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1 Introduction 

1.1 Purpose 

This reference manual describes the functionalities of NMR Product Test (NMRPT) 
software. NMRPT software is used for the standardized installation, the Acceptance, the 
NMR Final and Service Test of Bruker AVANCE III-series (and newer) instruments, and 
components. NMRPT provides standard Test Reports including spectra for document-
tation and signature. 

For a short introduction to NMRPT see ZHUB0001 in 1.5 Referenced Documents. For 
information about the test procedure and included experiments see ZUEP0102 in 1.5 
Referenced Documents. Both documents are also available from NMRPT Help menu. 

1.2 Area of Application 

This manual is written for all Bruker employees engaged in final testing, service and 
installation of NMR products using the NMRPT software. In addition to the installation 
procedure, a list of technical demonstrations (see Customer Acceptance Protocol of the 
installation) is outlined in the test documents in order to provide an effective introduction 
to the NMR system. 

1.3 Warning / Notice Signs 

 

 

1.4 Requirements 

Software: The NMRPT software is included in TopSpin 3.5 (and newer) 

Hardware: AVANCE III (and newer) 

  FOURIER is not supported 

Samples:  Bruker standard samples 
(see ZUEP0102 for information about samples and experiments) 

  

i Provides important information for the user. 



Introduction 

ZHUB0002 
 

8 
 

- confidential - 

1.5 Referenced Documents 

ZHUB0001 Internal NMRPT Short Guide (see NMRPT Help menu) 

ZUEP0102 Bruker Test Procedures for Avance NMR Systems  
(see NMRPT Help menu) 

H9469SA3 TopSpin User Manual  

H9776SA3 Processing Commands and References 

n.a.  TopShim Automatic Shimming Users Manual 

Z33073 Variable Temperature Control for NMR Probes User Manual 
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2 Conventions 

2.1 Abbreviations 
 

GUI Graphical User Interface 

NMRPT NMR Product Test 

NMRSAVE Call of nmr_save including NMRPT data 

PICS Probe Identification and Control System 

probe ID Probe Identification (unique, consists of the part number and the 
serial number of an NMR probe) 

sample ID  Sample Identification (unique) 

2.2 Terms and Definitions 
 

Additional PDF  
(of Inspection Lot) 

NMRPT allows additional PDF files to be included to the Addi-
tional Report of an Inspection Lot (e.g. additional experiments 
acquired outside NMRPT). 

Additional PDF  
(of report) 

NMRPT allows additional PDF files to be included to a report 
(e.g. additional experiments acquired outside NMRPT). 

Additional Report The Additional Report is an optional part of the NMRPT spectra 
PDF of each Inspection Lot. Additional measurements of 
NMRPT experiments (e.g. acquired under different conditions) 
can be added to the test document as Additional Report. 

base shim file A basic shim file for a probe, read in at the beginning of most 
Shim Commands. The shim file is named by the Probe ID. The 
base shim file is updated in NPT_prep_tsopt experiment. 

converted parameters The datasets included with NMRPT are automatically adjusted 
and optimized to the current hardware. 

Current Specs Specifications that can be set or changed in NMRPT. If 
Delivered Specs are available, Current Specs are set to the 
same values as a default. See Specs for further information. 

Customer Sample Each NMRPT test has to be done using standard samples. For 
comparison of results, a Customer Sample of the same compo-
sition can be used. It is created using laboratory chemicals 
available on site. 

Delivered Specs Specifications that are delivered with an external Inspection Lot. 
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Experimtent Queue Sequence of experiments in measurement order to be executed. 

finalized report A finalized report is the final document of a Final Test, Accep-
tance Test or Field Service Test for signature. Finalized means 
no further changes to the Inspection Lot, its experiments and 
results or documents can be done. 

Inspection Lot The Inspection Lot defines the test procedure for an NMR probe. 
It is created from Inspection Lot tab. The Inspection Lot consists 
of all experiments for a test combined with the required Bruker 
NMR standard samples. The experiment specifications are also 
included in the Inspection Lot. 

irregular experiment Depending on the experiment, it is set to irregular if measured 
under non-standard conditions (e.g. L23 options, temperature 
settings, flow settings). See documentation of experiments in 
ZUEP0102 for further information. Experiments are also set to 
irregular if status parameters of the data set are changed. 
Irregular experiments can not be used for report, but can be 
included in Additional Report. 

Library The set of experiments available in currently selected Inspection 
Lot. 

Nucleus of Interest The nucleus in focus of the experiment. The main result of the 
experiment is determined for this nucleus. 

Pairing A combination of an NMRPT experiment and a Bruker NMR 
standard sample defined in the Inspection Lot. 

permitted characters Permitted characters in NMRPT GUI text fields are the letters 
a-z(A-Z), the digits 0-9, ‘-‘ and ‘_’. No white space and no further 
special characters are permitted. 

protocol  The NMRPT test protocol is part of the NMRPT report. It 
includes the signature page. Further content depends on the 
Test Mode and the Report Type of the report. 

Queue see Experiment Queue. 

report The NMRPT report is the document of an Acceptance, Field 
Service or Final Test. It consists of a test protocol and a spectra 
PDF. An Additional PDF can be included. 

Recommended Flow The Recommended Flow is the gas flow for temperature control, 
defined in the PICS of a probe. 

Report Type NMRPT knows three different Report Types: Spectrometer 
Report, Probe Report and Accessories Report. The Report Type 
affects how many Inspection Lots can be included to the report. 

Shim Command NMRPT Shim Commands are shim sequences represented by 
Shim Command numbers. All commands included in a sequence 
have to be executable from TopSpin command line. User Shim 
Commands can be created. 
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Short PDF The Short PDF collates all single spectrum PDF files set to be 
used for report. 

single spectrum PDF A single spectrum PDF file is available from Results tab for each 
run of an experiment successfully acquired and processed. 

Specs/Specifications  Specifications are target values to be proved by NMRPT results. 
Depending on the experiment also specifications for the defintion 
of acquisition parameters exist. A Specs value of -1 means 
determination of results, but no comparing evaluation of results 
against specifications. Only positive values can be set  as 
Specs. 

spectra PDF The NMRPT spectra PDF is part of the NMRPT report. It 
includes all single spectrum PDF files of experiment runs set to 
be used for report. 

Test Mode NMRPT knows three different Test Modes: Final Test, 
Acceptance Test and Field Service Test. The Test Mode defines 
the kind of resulting report and affects the set of mandatory 
experiments for an Inspection Lot. 

Workspace Area in the NMRPT GUI hosting tabs of different functionality. 
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3 Overview 

3.1 About NMRPT 

NMRPT software provides a standardized Final Test, Acceptance Test and Field Service 
Test procedure of spectrometers and probes. 

A set of standardized experiments is provided by NMRPT as described in ZUEP0102 
accessible from NMRPT Help menu (see 1.5 Referenced Documents). But the user can 
select only from the subset feasible to the current hardware (combination of probe, 
console, and routing). The datasets included with the NMRPT are automatically adjusted 
and optimized to the current hardware. If user interaction is necessary, the software will 
guide the user (e.g. through the parameter optimization). 

A PDF file documents the results and spectra for each measurement successfully 
evaluated. NMRPT collates the results and spectra of all acquired experiments (one 
measurement per experiment) in a report. This report is the test document for the 
acceptance, a final test or a service of a spectrometer, parts of a spectrometer, a probe, 
or accessories. 

Receiver Gain (RG)  
The value for RG is predefined in each experiment. It is adjusted during setup. The usual 
standard values are RGmin or RGmax. In first case, NMRPT executes RGA to set the 
optimum value. In second case, NMRPT adopts the value. For a user controlled RG, the 
RG is set in the Preparation panel of NMRPT Acquisition page. RGmin and RGmax are 
derived from TopSpin configuration information (after execution of cf, see TopSpin 
manual). In NMRPT the maximum value of RGmax is limited to 203. If the RGmax value of 
the TopSpin configuration is lower, this value will be used. 

Carrier Frequencies (O1 and O2)  
The carrier frequency offset can be changed in all experiments where NMRPT does not 
optimize these settings. It is not recommended to change this except for the water 
suppression and MAS experiments when using specific options of L23 (see ZUEP0102, 
chapter 1.5 Referenced Documents or NMRPT Help menu). 

Loopcounter Parameter L23 
The loopcounter L23 is used to apply special conditions in NMRPT experiments. The 
values allowed for each experiment are provided in the experiment description in 
ZUEP0102 (see chapter 1.5 Referenced Documents or NMRPT Help menu). For some 
experiments (e.g. L23=27 in watersuppression experiment) changing the L23 value 
results in a non-standard experiment without a regular experiment output. 

Gradient Strength (GPZx)  
The used gradient strength (given in %) of all experiments (see ZUEP0102, chapter 
1.5 Referenced Documents or NMRPT Help menu) is related to a maximum gradient 
current of the probe. If the maximum current of a gradient amplifier differs from the one of 
the probe, the gradient strength is recalculated accordingly. 
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3.2 Test Modes 

The NMRPT software knows 3 different Test Modes: 

• Final Test 

• Acceptance Test 

• Field Service Test 

The Test Mode has to be selected at the beginning of a new NMR product test while 
creating the Inspection Lot. Every Test Mode has its own test protocol. For example the 
Acceptance Test includes a Customer Training Checklist, the acceptance agreement and 
the signature line for customer’s signature. 

3.3 Report Types 

The NMRPT software knows three different Report Types: 

• Spectrometer Report 

• Probe Report 

• Accessories Report 

A report consists of a test protocol and a spectra PDF. A Spectrometer Report consists of 
one or more probe tests. To cover a complex spectrometer type, it can be necessary to 
test with more than one single probe. So the Spectrometer Report includes the sum of all 
necessary probe tests and the specific spectrometer NMR tests. 

Therefore 9 different test protocols exist as a combination of Test Mode and Report Type: 

• Final Test Protocol, NMR Spectrometer 

• Acceptance Protocol, NMR Spectrometer 

• Field Service Protocol, NMR Spectrometer 

• Final Test Protocol, NMR Probe 

• Acceptance Protocol, NMR Probe 

• Field Service Protocol, NMR Probe 

• Final Test Protocol, Accessories 

• Acceptance Protocol, Accessories 

• Field Service Protocol, Accessories 
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3.4 NMRPT Documents 
The main document of NMRPT is the test report for signature. Beside this test report and 
its components, there are single spectra PDF files and a Short PDF providing information 
about the test results of an Inspection Lot. 

3.4.1 Test Report 

The NMRPT test report consists of a test protocol and a spectra PDF. As an optional part 
an Additional Report can be included to the spectra PDF. Optional additional PDF files 
(e.g. additional experiments from outside NMRPT) can also be included to the report. 

Three different Report Types are provided (see 3.3 Report Types and 5.4.5 Report Tab): 

• Spectrometer Report 
To cover a complex spectrometer type, it can be necessary to test with more than one 
single probe. So the Spectrometer Report can be based on multiple Inspection Lots. 
Therefore the report includes the sum of all necessary probe tests and the specific 
spectrometer NMR tests. 

• Probe Report 
A Probe Report covers the test of a single probe. It is based on one Inspection Lot 
covering all probe tests necessary for the probe type. 

• Accessories Report 
An Accessories Report covers all tests specific for the tested accessories. Therefor it 
can be based on multiple Inspection Lots, but can also be created without any 
Inspection Lot (e.g. if no NMR tests are applicable to an accessory). 

In combination with the available Test Modes – Final Test, Acceptance Test and Field 
Service Test (see 3.2 Test Modes) – 9 different test protocols are provided by NMRPT. 

A test report is created from Report tab (see 5.4.5 Report Tab). Each report is marked as 
preliminary while under review. To remove the label “preliminary” and to get the valid 
documents for signature, a report needs to be finalized. 
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3.4.1.1 Protocol 

The NMRPT test protocol consists of a signature page and a summary of all included 
Inspection Lots covering the test results of all experiments set to be used for report. In 
case of an Acceptance Protocol an Installation Checklist is included. The Service 
Protocol of a spectrometer includes a Service Checklist. 

 
Figure 3-1: Signature page of Acceptance Protocol NMR Spectrometer 

The signature page meets the requirements of each combination of Test Mode and 
Report Type. It provides information about tested hardware and the signing parties. In 
case of all Acceptance protocols also the wording of acceptance is included on signature 
page. 

3.4.1.2 Spectra PDF 

The spectra PDF includes all single spectrum PDF files of experiment runs set to be used 
for report. These spectra and the optional Additional Reports (including optional 
Additional PDFs of each Inspection Lot) are grouped to chapters by the Inspection Lot. 
Probe and spectrometer related information, information about the PICS, ATMA data and 
required samples are also included to the Inspection Lot chapter. Additional PDFs of the 
report are appended to the end of the Spectra PDF. 

A Probe Report covers one Inspection Lot chapter. In case of an Accessories Report the 
spectra PDF may collate multiple Inspection Lot chapters. The spectra PDF of a 
Spectrometer Report may also cover multiple Inspection Lot chapters and includes 
configuration information and IP config information about the spectrometer. 
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Additional Report (optional)  
The Additional Report is an optional part of NMRPT spectra PDF of each Inspection Lot. 
Additional measurement runs (e.g. acquired under different conditions) of NMRPT 
experiments can be added to the test document as Additional Report. 

Additional PDFs of Inspection Lot (optional)  
Additional PDF files can be included to the Additional Report of each Inspection Lot (e.g. 
additional experiments acquired outside NMRPT) from Results tab. See chapter 5.4.4 
Results Tab for further information. 

Additional PDFs of Report (optional)  
Additional PDF files can also be appended to the spectra PDF of each report on Report 
tab. See chapter 5.4.5 Report Tab for further information. 

3.4.2 Single Spectrum PDF 

A single spectrum PDF file is available from Results Tab for each run of an experiment 
successfully acquired and processed (indicated by a green status icon or yellow 
exclamation mark – see chapter 5.4.4 Results Tab).  

 
Figure 3-2: Single spectrum PDF 

The single spectra PDF shows the resulting spectrum (Figure 3-2 (2)). Depending on the 
experiment also an expansion, multiple spectra or plots are provided. The titel of the 
single spectrum PDF (Figure 3-2 (1)) provides the results of the acquired experiment 
including the comparison to specification values if available (see chapter 5.4.1 Inspection 
Lot Tab). The title also includes information about the used NMR system, the TopSpin 
version, the probe and the sample the experiment was acquired on. Further information 
e.g. about the sample depth or rotation status may also be provided. Right of the 
spectrum (Figure 3-2 (3)) acquisition, processing and additional parameters are shown 
and information about the applied shim sequence is provided. 

1 

2 

3 
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The single spectrum PDF is the result page of an experiment run as collated by the short 
PDF or the spectra PDF of a report if the respective run is included. 

 

 

3.4.3 Short PDF 

The Short PDF provides a shortened preview of the current spectra PDF for this 
Inspection Lot: It collates all single spectrum PDF files set to be used for report but 
includes no further information about the probe and no Additional Report or Additional 
PDF files. The Short PDF is accessible from Results tab. 

 
  

i Further information about experiments, parameters and resulting spectra is provided in 
ZUEP0102 accessible via NMRPT Help menu (see chapter 1.5 Referenced Documents). 
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3.5 Workflow 
This basic NMRPT workflow shows the procedure from setup over measurement to the 
creation of a finalized report. All additional options and optional settings beside this basic 
workflow can be found in chapter 5 GUI-Description. 

An Acceptance Test of a probe is used as an example. The probe is assumed to be 
installed and configured in TopSpin via edprobe and all customer and spectrometer 
information to be provided via edcstm. The TopSpin prosol tables are assumend to be 
prefilled with approximate pulse values. The standard samples are assumend to be 
available. A sample changer is not required (see chapter 4.1 Sample Change Modes), 
but if available, the sample changer is recommended to be ready for use.  

 

 

1. Enter nmrpt to TopSpin command line to start NMRPT. The NMRPT main window is 
divided into four main areas:  

(1) Menu Bar 
(2) Acquisition Bar  
(3) Workspace 
(4) Navigation 

 
Figure 3-3: NMRPT main window at first start. 

 

i 
The commands edprobe, edcstm and the prosol functionality are part of TopSpin. 
Further information is provided in the TopSpin manuals (see chapter 1.5 Referenced 
Documents). 

1 

2 

4 

3 
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2. On the File menu shown in Figure 3-4 (1), point to New, and then click Probe / 
Inspection Lot (2). The New Probe / Inspection Lot dialog opens up.  

 
Figure 3-4: Create new Inspection Lot for probe 

 

3. Enter an Inspection Lot Name (Figure 3-5 (1)) and select the Probe ID from the list 
(Figure 3-5 (2)). Keep the default settings of further options. Click OK to apply and 
continue. 

 
Figure 3-5: Basic settings for a new Inspection Lot 

 

4. Select a sample for each experiment or a group of experiments as shown in 
Figure 3-6. Click OK to apply and continue.  

 
Figure 3-6: Sample selection for experiments 

 

1 

2 
 

1 
2 
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5. The  Inspection Lot tab opens in NMRPT Workspace. Click on table entries to 
select a combination of experiment (Figure 3-7 (1)) and sample (Figure 3-7 (2)). The 
corresponding experiment specifications are listed in a third table shown in 
Figure 3-7 (3).  

 
Figure 3-7: Set experiment specifications on Inspection Lot tab 

 

6. Click into Current Specs cell of an experiment specification item in table (3) shown in 
Figure 3-7. Enter the new value to be applied.  

 

7. Repeat step 5 and 6 for all experiments to be specified. 

 

8. When finished, click Save (Figure 3-7 (4)) to apply all changes. 

 

9. In Menu Bar, select Edit menu shown in Figure 3-8 (1) and click Sample List (2). 
The Sample List dialog opens up.  

 
Figure 3-8: Open Sample List 

 

 

i Step 9 and 10 can be skipped if no sample changer is used. These steps are only 
relevant to set appropriate default sample changer positions. 

1 

2 

3 
4 

1 

2 
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10. In Sample List dialog (Figure 3-9) click Set Default Holder (3) and place each 
sample in the sample changer position shown in Holder column (1). Click Apply 
and Close (2) when finished.  

 
Figure 3-9: Set Default Holder in Sample List 

 
11. Click the  Acquisition tab (Figure 3-10 (1)) in NMRPT Workspace to switch to the 

Acquisition tab.  

 
Figure 3-10: Select Inspection Lot on Acquisition tab 

 

12. On the Acquisition tab (Figure 3-10) click Select Inspection Lot (2). 

 

13. Choose Inspection Lot to measure from the list in the dialog window shown in 
Figure 3-11. Click OK to apply the selection. Click Cancel to abort selecting an 
Inspection Lot for acquisition.  

 
Figure 3-11: Select Inspection Lot from list 

3 

1 

2 

1 

2 
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14. Click the Recommended Experiment Sequence check box (Figure 3-12 (1)) in the 
Library. The recommended set of experiments in recommended measurement order 
is selected.  

 
Figure 3-12: Enqueue Recommended Experiment Sequence 

 

15. Click Add to Queue (Figure 3-12 (3)) located in Experiment Preparation panel to 
enqueue experiments for measurement. The experiments are then listed into the 
Experiment Queue (Figure 3-12 (2)). 

 

16. Click Start (Figure 3-13 (1)) located in the Acquisition Bar to start the sequence of 
experiments as listed in Experiment Queue (Figure 3-13  (2)).  

 
Figure 3-13: Start of Experiment Queue 

1 

3 

2 

1 
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17. In the Startup Check dialog (Figure 3-14) click wsh (1). A base shim file is written.  

 
Figure 3-14: Startup Check dialog 

 

 

18. If a red error symbol  appears next to Recommended Flow at Standard 
Condition (Edprobe) in Startup Check dialog (Figure 3-14): Click Edprobe 
(Figure 3-14 (2)) to set Recommended Flow in TopSpin edprobe dialog. 

 

 

19. In Startup Check dialog (Figure 3-14) click OK to start the measurements. 

 
20. Open  Results tab from Navigation (Figure 3-15 (1)): The Results tab is a sub-

item of the Inspection Lot. Expand the Inspection Lot item and click the Results item 
to open. While the Queue is acquired, the results will appear one after another.  

 
Figure 3-15: Check of experiments on Results tab 

i The write shim command wsh is part of TopSpin. Further information is provided in the 
TopSpin manuals (see chapter 1.5 Referenced Documents). 

i The edprobe command is part of TopSpin. Further information is provided in the 
TopSpin manuals (see chapter 1.5 Referenced Documents). 

1 
2 

2 
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21. Check if all experiments were successful. Success is indicated by a green icon  in 
Status column (Figure 3-15 (2)). 

 

22. Working with non-successful experiments: To re-execute, go back to step 14 but 
select the individual experiments instead of the Recommended Experiment 
Sequence. To change specifications, edit as described in steps 5 and 6. See chapter 
5 GUI-Description for additional options.  

 

23. On the File menu shown in Figure 3-16 (1), point to New, and then click Report (2). 
The New Report dialog opens.  

 
Figure 3-16: Create new Report for probe 

 

24. Enter a Report Name (Figure 3-17 (1)) and select the Inspection Lot from the list 
(Figure 3-17 (2)). Keep the default settings of further options. Click OK to apply and 
continue. The Report tab (Figure 3-18) opens in NMRPT Workspace.  

 
Figure 3-17: New Report dialog 

 

 
  

i 
Information for Report Creation 
Enter all available information on Report tab. This information is used to create and fill 
the final document for signature. Empty information may result in an invalid document. 

1 

2 
 

1 
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Figure 3-18: Preparation of NMRPT report on Report tab 

 

25. Click edcstm (Figure 3-18 (1)) under General Information to open TopSpin Edcstm 
dialog. Enter all mandatory information.  

 

 

26. Under General Information (Figure 3-18) enter Engineer and Duration of 
Warranty in months. 

 

27. Under Probe Information (Figure 3-18) enter Order No. and Contract No. 

 

28. Scroll down to find Installation, Training, Acceptance and Warranty and Optional 
Components check lists. Select statuses for the list entries.  

 

29. Click Save (Figure 3-18 (6)) to apply all changes.  

 

30. Click Create Protocol & Spectra (Figure 3-18 (5)) to create a preliminary report.  

 

31. Check the report documents. Click Show Protocol (Figure 3-18 (4)) to access 
protocol PDF. To access spectra PDF click Show Spectra (Figure 3-18 (3)).  

 

32. Click Finalize (Figure 3-18 (2)) to create the valid report.  

 

i The edcstm command is part of TopSpin. Further information is provided in the TopSpin 
manuals (see chapter 1.5 Referenced Documents). 

1 

6 5 2 3 4 
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33. In Finalize dialog (Figure 3-19) click Yes to accept, that the Inspection Lot used for 
the finalized report can not be used for another report. 

 
Figure 3-19: Finalize report message 

 

34. Access the finalized report as described in step 31. 
 

 

 

 

i For basic information about NMRPT also see the NMRPT Short Guide accessible via 
NMRPT Help menu (ZHUB0001, chapter 1.5 Referenced Documents). 
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4 Practical Advices 

4.1 Sample Change Modes 

NMRPT can be used with a sample changer but also handle manual sample change. 

If a sample changer is detected, the option to use the sample changer (see 5.1.2.11 
Configuration) is set automatically as a default but can be deselected. If deselected, all 
samples are automatically configured to be changed manually. 

It is also possible to change specific samples manually. Set manual change option for 
individual samples in Sample List (see 5.1.2.9 Sample List). 

If no sample changer is detected by NMRPT, the useage of a sample changer is 
automatically deselected. All samples are automatically configured to be changed 
manually. 

In manual changing mode, NMRPT pauses the Queue and after an acoustic signal 
dialogs are provided to guide the user through sample change procedure. 

 

 

4.2 Gas Flow Control 

As a default NMRPT handles setting the gas flow for temperature control in each 
experiment. The desired flow value is set at the beginning of each experiment. The 
Recommended Flow, a value provided by the PICS of a probe, is applied for all 
experiments except for watersuppression experiments. These watersuppression 
experiments are named by the individual flow value applied. 

Select Skip Gas Flow Setting (Figure 4-1 (5)) on Probe Setup tab to skip setting the gas 
flow by NMRPT for all experiments of all Inspection Lots of this probe as a default. 

To skip setting the gas flow by NMRPT for a single experiment, Select Skip Gas Flow 
Setting in Experiment Preparation panel on Acquisition tab. 

If the temperature unit is set to external mode (e.g. operating some MAS and HRMAS 
probes), Skip Gas Flow Settings are disabled and automatically applied. 

 

  

i 
Holder position 0 means manual sample change. If the Use Sample Changer option is 
deselected in NMRPT Configuration, all holder positions are set to 0. 
If the Use Sample Changer option is selected, samples set to be changed manually are 
not included to the Recommended Experiment Sequence. For LC, HRMAS and MAS 
often there is no appropriate sample changer available. Therefore especially in these 
cases it may be useful to deselect useage of a sample changer to include all experiments 
to Recommended Experiment Sequence. 

i Watersuppression experiments are set to irregular if setting the gas flow is skipped. 
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Figure 4-1: Probe Setup tab – Flow, Temperature and Shim options 

4.3 Temperature Control 

By default, the target temperature for temperature control is handled by NMRPT. The 
desired temperature is set at the beginning of each experiment. The Standard 
Temperature, as set on Probe Setup tab, is applied for all experiments. 

Select Skip Temperature Setting (Figure 4-1 (4)) on Probe Setup tab to skip setting the 
temperature by NMRPT for all experiments of all Inspection Lots of this probe as a 
default. 

To skip setting the temperature by NMRPT for a single experiment, Select Skip 
Temperature Setting in Experiment Preparation panel on Acquisition tab. 

 

 

4.3.1 Selftune 

BSVT temperature unit installed 

If option Skip Temperature Setting is not applied, NMRPT handles selftune process 
automatically. NMRPT reads the selftune settings for the current probe and target flow 
before acquisition of each experiment. If no selftune settings are available for this flow, 
NMRPT initializes a selftune and the creation of the corresponding selftune settings. 

i Watersuppression experiments are set to irregular if setting the temperature is skipped. 

1 
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The selftune settings are named by the Probe ID and the relevant gas flow (or “external” 
in case of external mode for gas flow) appended with underscore, e.g. 
Z104275_0118_400. 

All available selftune settings are listed in Temperature Control Suite window, accessible 
via vtudisp command from TopSpin command line. To re-execute a selftune for a 
specific gas flow, delete the corresponding selftune settings from this list. 

 

 

4.4 NMRPT Shim Handling 

NMRPT Shim Commands encompass sequences of combined TopSpin and TopShim 
commands. The NMRPT Shim Commands are indicated by shim numbers.  

Default Shim Method 
In NMRPT Probe Setup Tab (see 5.4.2 Probe Setup Tab) select the Default Shim 
Method (Figure 4-1 (1)) for this probe. The selection is applied to all Inspection Lots of 
the probe. 

 

 

Reduce Ordmax Options 
The ordmax parameter of TopShim defines an upper limit for the order of shim functions 
used by TopShim. In NMRPT Probe Setup tab multiple options (Figure 4-1 (2)) are 
provided to reduce the maximum shim orders according to this ordmax parameter.  

These NMRPT maximum shim order options are applied to the NMRPT Shim Commands 
and therefore the complete sequence encompassed. Available options are: 

• Max. 2H On-Axis Order 
• Max. Proton On-Axis Order 
• Max. Proton Off-Axis-Order 

As a default, these settings are applied to all experiments. To skip these settings, 
deselect Reduce Ordmax according to probe setting in Experiment Preparation of a 
single experiment.  

Z-Shim Correction (not MAS, SOL probes) 
NMRPT Probe Setup Tab provides a Z- and Z2-Shim Correction (Figure 4-1 (3)) to be set 
for a probe. The correction is applied at the end of the shim process during water 

i The Temperature Control Suite is a software interface available if a Bruker Smart 
Variable Temperature unit is installed. See Z33073 (chapter 1.5 Referenced Documents) 
for further information. 

i 
The selected Default Shim Method affects the default Shim Commands of all 
experiments included to all Inspection Lots of the probe. The default Shim Command is 
the preselected Shim Command provided in Experiment Preparation panel on Acquisition 
tab. 
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suppression experiments. If NMRPT Shim Command 999 (skip shimming) is selected for 
an experiment, Z- and Z2-Shim Correction is not applied. 

4.5 Locksetting 

For HR and HRMAS probes NMRPT provides the opportunity of an automatic and 
solvent-dependent optimization of lock parameters.  

The locksetting experiment optimizes the lock parameters according to the LOOPADJ 
macro. As a basis of computation the standard parameters of the corresponding solvent 
from EDSOLV are used. The results are written to the Edlock tables. In case of the 
solvents Acetone and Benzene-D6 stronger coupling conditions (according to a lock gain 
of 83.9 dB) are applied.  

Select Do Locksetting after sample change option in Startup Check dialog (see chapter 
5.2 Acquisition Bar) to execute a 2H locksetting experiment after each sample change. 
This experiment is acquired automatically in background before the first experiment of 
this sample is executed. 

To do 19F locksettings, acquire the corresponding locksetting experiment from Queue.  

The locksetting experiments are named NPT_prep_locksettings and the lock nucleus 
appended with underscore. 

 

 
  

i 
The LOOPADJ macro, the Edlock and the Edsolv tables are part of TopSpin.  Further 
information is provided in the TopSpin manuals (see chapter 1.5 Referenced 
Documents). 
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4.6 Converted Parameter Sets 

The datasets included with NMRPT are automatically adjusted to the current hardware 
and spectrometer routing when an experiment is added from Library to Experiment 
Preparation panel or Experiment Queue. NMRPT keeps converted experiment 
parameters while open and a probe stays defined as current via edprobe in TopSpin. 
Converted parameters can be deleted manually (see 5.1.2.10 Remove Converted 
Parameters) to enforce parameters to be converted again, e.g. if manual re-routing is 
necessary. 

 

 

4.7 Additional Information 

Additional Information for each run of an experiment is accessible from Results tab (see 
5.4.4 Results Tab). The Show Additional Info dialog provides detailed status and log 
messages of the run. Show Expert Messages option provides more detailed expert 
information. 

 
Figure 4-2: Show Additional Info dialog (see Additional Information in 5.4.4 Results Tab 

i 
The definition of the spectrometer routing is part of TopSpin. It can be accessed via 
edasp command from TopSpin command line. The edprobe command is also part of 
TopSpin. Further information is provided in the TopSpin manuals (see chapter 1.5 
Referenced Documents). 
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Besides the log messages one can find the information included in the TopShim report 
file via clicking on the TopShim Report field next to the Log Messages field. 

     
Figure 4-3: Show Additional Info dialog with TopShim report (see Additional Information in 5.4.4 Results Tab) 

4.8 How to Debug 

Information for debugging purposes concerning NMRPT can be found in several places, 
specific for the problems which occurred: 

• The Additional Information dialog of each experiment, accessible from Results tab, 
provides detailed status and text messages of the experiments including Expert 
Messages for debugging purposes. 

• Use Show in TopSpin button on Results tab to access the spectrum, the data set, 
acquisition and processing parameters, the routing etc. of an NMRPT experiment 
run to debug experiment related problems. 

• TopSpin history file includes experiment related log entries of NMRPT. 

• TopSpin Java history file provides GUI related log information about NMRPT. 

 

 
  

i 
TopSpin history file and Java history file are both available combined in TopSpin history 
and protocol dialog. Use hist command from TopSpin command line to open this 
dialog. The hist command is part of TopSpin. Further information is provided in the 
TopSpin manuals (see chapter 1.5 Referenced Documents). 
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4.9 Troubleshooting 

Configuration, Sample List, Shim Command 

Indication Solution 

Configuration dialog: Usage 
of Sample Changer not 
selected, number of holder 
positions not set 

Check if the sample changer is correctly installed 
and configured in TopSpin. If so, select usage of 
sample changer in NMRPT and set number of 
holder positions manually. 

Sample List dialog: 
Availability of sample can not 
be changed 

The availability of Customer Samples can not be 
changed. Delete a Customer Sample to remove it 
from the list of available samples. 

Shim Command dialog: Edit 
Command button is disabled 

Default Shim Commands can not be edited. Select 
a Shim Command Number between 800 and 824 to 
create a custom Shim Command. 

Table 4-1: Troubleshooting – Configuration, Sample List, Shim Command 

Inspection Lot 

Indication Solution 

Probe not listed to create a 
new Inspection Lot for 

The probe needs to be installed to TopSpin via 
edprobe at least once. See TopSpin manuals 
(chapter 1.5 Referenced Documents) for information 
about how to install a probe via edprobe. 

Empty List of Mandatory 
Experiments while creating a 
new Inspection Lot 

An empty List of Mandatory Experiments indicates 
missing or inappropriate probe information. 
Continue the creation of the Inspection Lot to see if 
experiments are available on Inspection Lot tab. 

Experiments / samples 
missing in Inspection Lot tab 

Use TopSpin edprobe functionality (chapter 1.5 
Referenced Documents) to check all probe 
properties (e.g. probe type, diameter, nuclei, peak 
powers etc.). Correct probe properties are required 
to get an appropriate set of experiments for 
Inspection Lot. To fix incorrect PICS, please contact 
NMR support (see 6 Contact) 

Inspection Lot can not be 
changed 

The Inspection Lot is included to a finalized report 
can not be changed. Corresponding buttons are 
disabled. Delete the finalized report first and then 
edit the Inspection Lot. 

Table 4-2: Troubleshooting – Inspection Lot 
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Acquisition 

Indication Solution 

Wrong probe shown as 
Installed Probe  

The probe to be used needs to be the current probe 
according to TopSpin edprobe. See TopSpin 
manuals (chapter 1.5 Referenced Documents) for 
information about edprobe. 

Inspection Lot can not be 
selected for acquisition 

The Inspection Lot is included to a finalized report. 
Therefor the Inspection Lot is locked and can not be 
changed, e.g. by acquisition of new data. Delete the 
finalized report to make the Inspection Lot available 
again. 

Empty Library of experiments Check if the desired Inspection Lot is selected for 
Acquisition. Ensure that the required pairings of 
experiments and samples for this Inspection Lot are 
set to be measured. Check if the required samples 
are set available in Sample List. 

Non-Routable Experiments 
are listed in Library 

Depending on the hardware not all required nuclei 
for experiments of the Inspection Lot may be 
routable at the same time. Change current routing 
or check for errors via edasp and edasp probe. 
See TopSpin manuals (chapter 1.5 Referenced 
Documents) for information about edasp. 

Unexpected experiment 
settings in Experiment 
Preparation or Queue 

Check default settings for the current probe on 
Probe Setup tab. Also check settings for sample 
change modes in Sample List and NMR 

Queue is paused but Pause 
button was not used 

Check if Pause before Acquisition was selected for 
the upcoming experiment in Experiment Queue. 
Check if Pause before Sample Change was 
selected for the upcoming sample in Sample List. In 
both cases, press Start to continue. 
Check if Experiment Queue was paused due to 
failed experiments. If general steps of experiments 
fail (like RSH of standard shim file), the Queue is 
paused to avoid a series of failed experiments. 

Experiments in Queue are 
skipped 

Check if NMRPT was configured to skip 
experiments on samples with option Pause before 
Change in a certain time span. The experiments will 
remain enqueued while others are executed. 
Deselect this option to acquire all experiments in 
Queue order. 

A message about missing 
pulse or power values occurs 

Check if generic prosol tables for the current probe 
are filled correctly. For experiments including a 
manual interaction part demanding to check 
parameters: Set and check all required values 
including the ones listed in the message. 
See TopSpin manuals (chapter 1.5 Referenced 
Documents) for information about prosol. 

Experiment is aborted due to 
missing Specs 

A few experiments need certain specification values 
for acquisition. The abort dialog message provides 
further information. Set these Specs on Inspection 
Lot tab. 

Table 4-3: Troubleshooting – Acquisition 
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Results 

Indication Solution 

Experiment run is marked 
successful but can not be 
selected for report 

The experiment run was set irregular due to non-
standard conditions of the experiment (e.g. some 
L23 options). Select the experiment run for 
Additional Report to include it to the test report. See 
ZUEP0102 (chapter 1.5 Referenced Documents) for 
further information about standard and irregular 
conditions. 

Table 4-4: Troubleshooting – Results 

Report 

Indication Solution 

Inspection Lot not available 
for creation of new report 

Select the correct Test Mode in New Report dialog. 
Only Inspection Lots of the selected Test Mode are 
listed and can be included to a report. Inspection 
Lots can only be included to one report. To make an 
Inspection Lot available again, delete the existing 
report. 

Selection of multiple 
Inspection Lots for creation 
of a report is not possible 

Select the correct Report Type in New Report 
dialog. For Spectrometer and Accessories Reports 
multiple Inspection Lots can be selected for report. 
In case of a Probe Report only one Inspection Lot 
can be selected. 

Information on first page of 
report or checklist incomplete 

Check if all details on Report tab are filled with 
appropriate data. Click edcstm button on Report tab 
to check if all details of customer/spectrometer 
information are filled. 

Report can not be finalized Use Experiments Missing in Report button on 
Results tabs of all included Inspection Lots to check 
if all experiments included to the Inspection Lots 
have been acquired. To force finalization, remove 
the experiments from Inspection Lot.   
Check if all details on Report tab are filled with 
appropriate data. Click edcstm button on Report tab 
to check customer/spectrometer information. 

Table 4-5: Troubleshooting – Report 

  



Overview 

ZHUB0002 
 

38 
 

- confidential - 

4.10 How to Report a Bug 
If you have questions or problems concerning NMRPT, please, contact your local Key 
User. Further support is provided by the NMR Support (see chapter 6 Contact). 

When you identify a major bug in NMRPT, please, report it to Bruker NMR/MRI Software 
Knowledge Base: 

http://www.bruker.com/nc/bkb_access.html 

All NMRPT specific bug reports can be found under the category combination of 
“TOPSPIN” (Program list) and “product test” (Component list). Please, ensure that the 
bug was not reported yet. Assign a new bug report to the category combination of 
“TOPSPIN” and “product test” (select from Component list), too. 

When reporting a bug, always have an NMRSAVE backup of the reported state ready at 
hand. Select NMRSAVE from NMRPT file menu to create this backup of installation 
specific files including all NMRPT data and NMRPT measurement results.  

 

http://www.bruker.com/nc/bkb_access.html
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5 GUI-Description 
This NMRPT GUI Description is a reference manual with detailed descriptions of all 
functionalities, options and settings in NMRPT, their application, effects and results. 

To start NMR Product Test software (NMRPT) use nmrpt command in TopSpin 
command line.The NMRPT software opens up in a separate window divided into four 
main areas: 

(1) Menu Bar 
(2) Acquisition Bar  
(3) Workspace 
(4) Navigation 

 
Figure 5-1:  NMRPT main window with main areas 

5.1 Menu Bar 

5.1.1 File  

File menu shown in Figure 5-2 (1) provides 

• the creation of new Inspection Lots (3) 
• the creation of new reports (2) 
• NMRSAVE option (including all NMRPT data) (5)  
• the option to close NMRPT (4) 

 

1 
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Figure 5-2: File menu 

5.1.1.1 New > Probe / Inspection Lot 

On the File menu shown in Figure 5-2 (1), point to New (6), and then click Probe / 
Inspection Lot (3). The New Probe / Inspection Lot dialog (Figure 5-3) opens up. 

 
Figure 5-3: New Probe / Inspection Lot dialog 

New Probe / Inspection Lot Dialog (Figure 5-3) 
(1) Inspection Lot Name 

Enter an individual name for the new Inspection Lot (see chapter 2.2, permitted 
characters). The current date is suggested as a default. 

(2) Probe ID 
From the list select the probe the new Inspection Lot is created for. The list contains 
all probes registered to TopSpin via edprobe. The probe does not need to be 
currently installed to create the Inspection Lot. The characteristics of the probe affect 
the sets of available and mandatory experiments (4). 

 

 

(3) Test Mode 
Select the Test Mode from the list. The Test Mode defines the kind of resulting report 
and affects the set of mandatory experiments (4) for the Inspection Lot. 

(4) Selected Probe – Show and set mandatory experiments available  
Select this checkbox to set combinations of mandatory experiments and samples 
available for this Inspection Lot. The selected Probe ID (2) and Test Mode (3) affect 
the set of mandatory experiments. This option opens a subsequent dialog (shown in 
Figure 5-4) during the creation of the Inspection Lot. 

i The edprobe command is part of TopSpin. Further information is provided in the 
TopSpin manuals (see chapter 1.5 Referenced Documents). 
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(5) NPTCS File 
This file contains the customer specification. 
It can be downloaded from http://nmr-product-test.bruker.com for probes produced 
after August 2016. When a file has been loaded earlier on, the input field is disabled 
and shows the text “From exsiting File”. 
For newer probes, connected direct with BFB, the file is provided by the probe. In 
this case the input field is disabled and shows the text “From Probe”. 

(6) Spectrometer Report – Show and set mandatory experiments available  
If a Spectrometer Test is done, select this check box to add a set of spectrometer 
specific experiments to the Inspection Lot. These experiments usually have to be 
included in only one of the Spectrometer Report related Inspection Lots. An 
additional dialog (shown in Figure 5-5) opens during the creation of the Inspection 
Lot. 

(7) Inspection Lot is used with Plugin 
If the probe is equipped with a plugin, select this check box. Plugin Part No (8) and 
Plugin Serial No (9) need to be entered. This option modifies the sets of 
recommended respectively mandatory experiments for a plugin test. 

(8) Plugin Part No  
If (7) is selected, enter the part number of the plugin. The input is disabled if (7) is 
deselected. 

(9) Plugin Serial No  
If (7) is selected, enter the serial number of the plugin. The input is disabled if (7) is 
deselected. 

(10) Click OK to apply all settings and continue the creation of the Inspection Lot. 
Depending on the selected options (see (4) and (6)) additional dialogs as shown in 
Figure 5-4 and Figure 5-5 open subsequently. 

(11) Click Cancel to abort the creation of the Inspection Lot. 

Selected Probe – List of Mandatory Experiments Dialog (Figure 5-4)  
If Selected Probe – Show and set mandatory experiments available (Figure 5-3 (4)) was 
selected and no NPTCS file is provided in New Probe / Inspection Lot dialog, this dialog 
opens.  

 
Figure 5-4: List of Mandatory Experiments 

(1),(2) Select a sample (2) for each group of experiments (1). Use scroll bar to access all 
entries. 

3 4 

1 
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http://nmr-product-test.bruker.com/
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(3) Click OK (3) to apply and continue the creation of the Inspection Lot. Depending 
on the selected option for a spectrometer test (Figure 5-3 (5)) a subsequent 
dialog opens. 

(4) Click Cancel (4) to skip setting the mandatory experiments available. The 
creation of the Inspection Lot is not aborted. Depending on the selected option for 
a spectrometer test (Figure 5-3 (5)) a subsequent dialog opens. 

List of mandatory Spectrometer Report Experiments (Figure 5-5)  
If Spectrometer Report – Show and set mandatory experiments available (Figure 5-3 (5)) 
was selected in New Probe / Inspection Lot dialog, this dialog opens up. 

 
Figure 5-5: List of mandatory Spectrometer Report Experiments 

(1) Select a sample (1) for each experiment to set combinations of experiments and 
samples available for this Inspection Lot. Use scroll bar to access all entries. 

(2) Click Select All (2) to select all experiments from list. 

(3) Click Deselect All (3) to deselect all experiments. 

(4) Click OK (4) to apply and continue the creation of the Inspection Lot. 

(5) Click Cancel (5) to skip setting spectrometer experiments available. The creation 
of the Inspection Lot is not aborted. 

Finally the new Inspection Lot opens as a tab in the Workspace of NMRPT main window. 
In this tab, further adjustments can be made (see 5.4.1 Inspection Lot Tab). 

5.1.1.2 New > Report 

 
Figure 5-6: File menu, New Report 

To create a new report, on the File menu shown in Figure 5-6 (1), point to New, and then 
click Report (2). The New Report dialog (Figure 5-7) opens up. 
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Figure 5-7: New Report dialog 

New Report Dialog (Figure 5-7) 

(1) Report Name 
Enter an individual name for the new report (see chapter 2.2, permitted characters). 
The current date is suggested as a default. 

(2) Test Mode 
Select the Test Mode from the list. The selected Test Mode affects the list of 
available Inspection Lots for Report (4) listed below. Only Inspection Lots of the 
selected Test Mode are available. 

(3) Report Type 
Select the Report Type from the list. The selected Report Type affects the number of 
selectable Inspection Lots in the list below (4). 

(4) Inspection Lots for Report 
Select the Inspection Lot respectively multiple Inspection Lots from the list to be 
included in the report. The list shows all Inspection Lots available in the selected 
Test Mode. 

• In case of a Probe Report one Inspection Lot can be selected.  
• In case of a Spectrometer Report multiple Inspection Lots can be selected.  
• In case of an Accessories Report from zero to multiple Inspection Lots can be 

selected. 

To select multiple Inspection Lots, press and hold CTRL, and then click each item. 

(5) Click OK to apply and continue the creation of the report. 

(6) Click Cancel to abort the creation of the Inspection Lot. 

5.1.1.3 NMRSAVE 

NMRSAVE saves installation specific files in a backup TAR-file as done by TopSpin au 
program nmr_save, but includes all NMRPT data and NMRPT measurement results. 

 
Figure 5-8: NMRSAVE 

On the File menu shown in Figure 5-8, point to New, and then click NMRSAVE (1). The 
resulting file is located in <tshome>/nmr_backup folder. 
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5.1.1.4 Close 

 
Figure 5-9: Close NMRPT 

Click Close (Figure 5-9 (1)) to exit NMRPT. Closing is prohibited if acquisition of the 
Experiment Queue is active or paused. To stop current Acquisition Queue use Stop 
button in Acquisition Bar. 

5.1.2 Edit 

Edit Menu (1) shown in Figure 5-10 provides functionalities to 

• copy an Inspection Lot (2) 
• rename an Inspection Lot (3) 
• delete an Inspection Lot (4) 
• rename a report (3) 
• delete a report (4) 
• rename a plugin (3) 
• delete a probe (4) 
• show and edit the Shim Command list (5) 
• show and edit the Sample List (6) 
• remove converted experiment parameters from NMRPT (7)  
• set NMRPT wide configurations (8) 

 
Figure 5-10: Edit menu 

  

i The nmr_save command is part of TopSpin. Further information is provided in the 
TopSpin manuals (see chapter 1.5 Referenced Documents). 
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5.1.2.1 Copy Inspection Lot 

On the Edit menu shown in Figure 5-10 (1), click Copy Inspection Lot (2) to copy an 
Inspection Lot including its experiment specifications to a new one.  

The new Inspection Lot can be assigned to a different Test Mode. This way, e.g. 
specifications of an Acceptance Test can be applied to a Service Test. No experiment 
results will be copied. 

Copy Inspection Lot Dialogs 

 
Figure 5-11: Copy Inspection Lot – source 

(1) Select an existing Inspection Lot to copy from the list (Figure 5-11 (1)). 

(2) Click OK (Figure 5-11 (2)) to continue copy process. The subsequent dialog shown 
in Figure 5-12 opens. 

(3) Click Cancel (Figure 5-11 (3)) to abort copying an Inspection Lot. 

 
Figure 5-12: Copy Inspection Lot – target 

(1) Test Mode 
Select the Test Mode (Figure 5-12 (1)) for the copy. 

(2) Name of new Copy 
Enter an individual Name of new Copy (Figure 5-12 (2)) (see chapter 2.2, permitted 
characters). The old name labled as Copy is suggested as a default (see 
Figure 5-12). 

(3) Click OK (Figure 5-12 (3)) to finish the copy process. The new Inspection Lot opens 
in the Workspace of NMRPT main window.  

(4) Click Cancel (Figure 5-12 (4)) to abort copying the Inspection Lot. 

5.1.2.2 Rename > Inspection Lot 

 
Figure 5-13: Rename Inspection Lot in menu 

To rename an Inspection Lot, on the Edit menu shown in Figure 5-13 (1), point to 
Rename, and click Inspection Lot (2). 
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Rename Inspection Lot Dialogs 

 
Figure 5-14: Rename Inspection Lot – choose Inspection Lot 

(1) Select the Inspection Lot to rename from the list (Figure 5-14 (1)) of available 
Inspection Lots.  

(2) Click OK (Figure 5-14 (2)) to continue to rename the Inspection Lot. The subsequent 
dialog shown in Figure 5-15 opens. 

(3) Click Cancel (Figure 5-14 (3)) to abort renaming an Inspection Lot. 

 
Figure 5-15: Rename Inspection Lot – rename 

(1) New Name for Inspection Lot 
Enter an individual New Name for Inspection Lot (Figure 5-15 (1)) (permitted 
characters, see chapter 2.2). The old name is suggested as a default (see 
Figure 5-15). 

(2) Click OK (Figure 5-15 (2)) to finish renaming the Inspection Lot. 

(3) Click Cancel (Figure 5-15 (3)) to abort renaming the Inspection Lot. 

5.1.2.3 Rename > Plugin 

 
Figure 5-16: Rename Plugin in menu 

To rename a plugin, on the Edit menu shown in Figure 5-16 (1), point to Rename, and 
click Plugin (2). 

Rename Plugin Dialogs 

 
Figure 5-17: Rename Plugin – choose Inspection Lot 

(1) Select the Inspection Lot including the plugin to rename from the list 
(Figure 5-17 (1)) of available Inspection Lots with plugins.  
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(2) Click OK (Figure 5-17 (2)) to continue to rename the plugin. The subsequent dialog 
shown in Figure 5-18 opens. 

(3) Click Cancel (Figure 5-17 (3)) to abort renaming a plugin. 

 
Figure 5-18: Rename Plugin – rename Part No 

(1) New Plugin Part No 
Enter the New Plugin Part No (Figure 5-18 (1)) (see chapter 2.2, permitted 
characters). The old Part No is suggested as a default. 

(2) Click OK (Figure 5-18 (2)) to continue to rename the plugin. The subsequent dialog 
shown in Figure 5-19 opens. 

(3) Click Cancel (Figure 5-18 (3)) to abort renaming a plugin. 

 
Figure 5-19: Rename Plugin – rename Serial No 

(1) New Plugin Serial No 
Enter the New Plugin Serial No (Figure 5-19 (1)) (see chapter 2.2, permitted 
characters). The old Serial No is suggested as a default. 

(2) Click OK (Figure 5-19 (2)) to finish renaming the plugin. 

(3) Click Cancel (Figure 5-19 (3)) to abort renaming a plugin. 

5.1.2.4 Rename > Report 

 
Figure 5-20: Rename Report in menu 

To rename a report, on the Edit menu shown in Figure 5-20 (1), point to Rename, and 
click Report (2). 

Rename Report Dialogs 

 
Figure 5-21: Rename Report – choose report 

(1) Select the report to rename from the list (Figure 5-21 (1)). 
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(2) Click OK (Figure 5-21 (2)) to continue to rename the report. The subsequent dialog 
shown in Figure 5-22 opens. 

(3) Click Cancel (Figure 5-21 (3)) to abort renaming a report. 

 
Figure 5-22: Rename Report – rename 

(1) New name for Report 
Enter the New Name for Report (Figure 5-22 (1)). (see chapter 2.2, permitted 
characters). The old name is suggested as a default. 

(2) Click OK (Figure 5-22 (2)) to finish renaming the report. 

(3) Click Cancel (Figure 5-22 (3)) to abort renaming a report. 

5.1.2.5 Delete > Probe 

If a probe is deleted from NMRPT, all Inspection Lots, results and measurement data of 
this probe are deleted. Deletion of a probe is not possible if reports are based on at least 
one Inspection Lot of the probe. These reports need to be deleted first. 

 
Figure 5-23: Delete Probe in menu 

To delete a probe from NMRPT, on the Edit menu shown in Figure 5-23 (1), point to 
Delete, and click Probe (2). 

Delete Probe Dialog (Figure 5-24) 

 
Figure 5-24: Delete Probe – choose probe 

(1) In the dialog (Figure 5-24) select the probe (1) to delete. 

(2) Click OK (2) to continue to delete the probe. 

(3) Click Cancel (3) to abort deleting a probe. 
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5.1.2.6 Delete > Inspection Lot 

If an Inspection Lot is deleted, all measurement data and results of this Inspection Lot are 
deleted. Deletion of an Inspection Lot is not possible if a report based on the Inspection 
Lot exists. The report needs to be deleted first. 

 
Figure 5-25: Delete Inspection Lot in menu 

To delete an Inspection Lot from NMRPT, on the Edit menu shown in Figure 5-25 (1), 
point to Delete, and click Inspection Lot (2). 

Delete Inspection Lot Dialog (Figure 5-26) 

 
Figure 5-26: Delete Inspection Lot – choose Inspection Lot 

(1) In the dialog (Figure 5-26) select the Inspection Lot (1) to delete. 

(2) Click OK (2) to continue to delete the Inspection Lot. 

(3) Click Cancel (3) to abort deleting an Inspection Lot. 

 

 

5.1.2.7 Delete > Report 

• If a report is deleted, the corresponding Inspection Lot can be deleted. 
• If the deleted report was of finalized state, the corresponding Inspection Lot and its 

results are unlocked: The Inspection Lot can be changed. 
• Deleting all reports of one probe allows deleting the probe from NMRPT. 
• Deleting a report does not delete any Inspection Lot or measurement data.  

i 
Deleting a probe from NMRPT:  
All Inspection Lots, results, and measurement data of this probe are deleted! 
Deletion of a probe is disabled if Inspection Lots of the probe are used in reports. 

i 
Deleting an Inspection Lot from NMRPT:  
Attention! All results and NMR measurement data of this Inspection Lot are deleted! 
Deletion of an Inspection Lot is disabled if it is used for a report. 
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Figure 5-27: Delete Inspection Lot in menu 

To delete a report from NMRPT, on the Edit menu shown in Figure 5-27 (1), point to 
Delete, and click Report (2). 

Delete Report Dialog (Figure 5-28) 

 
Figure 5-28: Delete Report – choose report 

(1) In the dialog (Figure 5-28) select the report (1) to delete. 

(2) Click OK (2) to continue to delete the report. 

(3) Click Cancel (3) to abort deleting a report. 

 

 

5.1.2.8 Shim Command 

The NMRPT Shim Command list (Figure 5-30) shows the shim sequences connected to 
each NMRPT Shim Command Number. Entries with Shim Command numbers 800 to 824 
are editable and can be filled with user defined shim sequences. 

 
Figure 5-29: Shim Command list in menu 

On the Edit menu shown in Figure 5-29 (1), click Shim Command (2) to open Shim 
Command list dialog. 

i 
Deleting a report from NMRPT:  
The corresponding Inspection Lot is available again and can be changed or deleted. 
Deleting all reports of one probe allows deleting the probe from NMRPT. 
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Figure 5-30: Shim Command list 

Shim Command Dialog (Figure 5-30) 

(1) In Shim Command list the shim sequences connected to each NMRPT Shim 
Command Number (1) are shown. 

(2) Edit Command 
Select a Shim Command list item (1) and click Edit Command (2) to edit the 
sequence of this Shim Command number. The Edit Command dialog (Figure 5-31 ) 
opens. The Edit Command button is disabled for default Shim Command numbers 
other than 800 to 824. 

(3) Click Close (3) to close Shim Command dialog. 

Edit Command Dialog (Figure 4-32) 

 
Figure 5-31: Edit Shim Command dialog 

(1) Shim Command Number 
The Shim Command Number (1) which is currently edited is shown above the 
Sequence list (2). 

(2) Sequence 
The Shim Commands are listed one per row in the Sequence list (2) in the order of 
execution. Click an item in Sequence column to edit. 

(3) Move Up 
Select an item in Sequence list (2) and click Move Up (3) to move the item up in the 
Sequence list. 

(4) Move Down 
Select an item in Sequence list (2) and click Move Down (4) to move the item down 
in the Sequence list. 
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(5) Add 
Click Add (5) to add a new item to the Sequence list. 

(6) Remove 
Select an item in Sequence list (2) and click Remove (6) to remove the item from 
the Sequence list. 

(7) Click Close (7) to close Edit Command dialog. 

 

 

5.1.2.9 Sample List 

In NMRPT Sample List all samples required by experiments included in available 
Inspection Lots are listed. 

• Detail information about the samples is provided. 
• The sample changer holder positions are set. 
• The availability of the samples can be changed. 
• Customer Samples can be created (as a copy of the standard samples). 

  
Figure 5-32: Sample List in menu 

On the Edit menu shown in Figure 5-32 (1), click Sample List (2) to open Sample List 
dialog. 

Sample List Dialog (Figure 5-33) 

 
Figure 5-33: Sample List 

  

i 
NMRPT Shim Command Number 999 means skip shimming.  
All shim commands added to a sequence of a Shim Command Number are to be 
executable via TopSpin command line. Further information about shim commands is 
provided in the TopSpin manuals (see chapter 1.5 Referenced Documents). 
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(1) The filter bar (1) allows to list only samples matching the selected criteria in the 
sample list below. Available criteria are: Sample ID, Diameter, Product Group and 
Probe. 

(2) Click the status icon of a listed sample in Available column (2) to change its 
availability. A green icon  means available, a red icon  means not available.  

 

 

(3) Click the holder position of a sample in Holder column (3) to edit the holder position. 
Holder position 0 means manual change of the sample. To set default holder 
positions see (7). 

 

 

(4) Click the status icon (4) in Pause before Change column to pause the Acquisition 
Queue before changing to this sample. A green icon  means pause, a red icon  
means no pause before sample change. 

(5) Detail 
Click Detail (5) to open Sample Detail information dialog (see below and 
Figure 5-34). 

(6) Show all Samples 
Click Show all Samples (6) to open Show all Samples dialog (see below and 
Figure 5-35). In this dialog Customer Samples can be created. 

(7) Set Default Holder 
Click Set Default Holder (7) to assign default holder positions to the most frequently 
used standard samples currently listed in Sample List. This option requires those 
samples to be placed in these holder positions. This button is disabled if the use of a 
Sample Changer is deselected. 

(8) Reload 
Click Reload (8) to revert all changes not applied yet. 

(9) Click Close (9) to close Sample List dialog without applying recent modifications. 
(10) Apply and Close 

Click Apply and Close (10) to save all recent modifications and close Sample List. 

 
  

i 
Setting a sample unavailable removes all dependent experiments from Library on 
Acquisition tab. Experiments already enqueued are also affected and will be lost from 
Queue. The affected experiments remain part of the Inspection Lot and will become 
executable again when the sample is set to status available. 

i 
Holder position 0 means manual sample change. If the Use Sample Changer option is 
deselected in NMRPT Configuration, all holder positions are set to 0. 
If the Use Sample Changer option is selected, samples set to be changed manually are 
not included to the Recommended Experiment Sequence. For LC, HRMAS and MAS 
often there is no appropriate sample changer available. Thereofore especially in these 
cases it may be useful to deselect useage of a sample changer to include all experiments 
to Recommended Experiment Sequence. 
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Sample Detail Dialog (Figure 5-34)  

In Sample List dialog (Figure 5-33) select a sample and click Detail (Figure 5-33 (5)) to 
open Sample Detail dialog. 

 
Figure 5-34: Sample Detail information 

Details about the selected sample are shown: Sample ID, Short Description, Solvent, 
Physical Condition, Sample Type, TopSpin Description, Temperature Max. [C], 
Temperature Min. [C], Diameter and Batch Number. 

(1) Enter an optional Batch Number (1) to add it to detail information of the sample. 

(2) Click Close (2) to apply changes and close Sample Detail dialog. 

Show all Samples Dialog (Figure 5-35)  
In Sample List dialog (Figure 5-33) click Show all Samples (Figure 5-33 (6)) to open 
Show all Samples dialog. 

 
Figure 5-35: Show all Samples 

In Show all Samples dialog all samples known by NMRPT are listed. The details 
provided for each sample can not be edited and are for information only. 

(1) The filter bar (1) allows to list only samples matching the selected criteria in the 
sample list below. Available criteria are: Sample ID, Diameter, Product Group and 
Probe. 

(2) The status icons in Used column (2) show if a sample was used in NMRPT before 
(independant of its current availability status (Figure 5-33 (2)). A green icon  
means used, a red icon  means not used. 
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(3) Copy selected sample to Customer Sample  
If a standard sample is not available and an equivalent sample based on common 
laboratory chemicals has to be used: Select the standard sample and click Copy 
selected sample to Customer Sample. 
 

 
Figure 5-36: New Customer Sample dialog 

In the subsequent dialog (Figure 5-36) enter a new Sample ID (Figure 5-36 (1)) (see 
chapter 2.2, permitted characters) and click OK (Figure 5-36 (2)) save the sample 
and to close the dialog. Click Cancel (Figure 5-36 (3)) to abort copying a standard 
sample to a new Customer Sample. 

 

 

(4) Delete Customer Sample 
To delete a Customer Sample, select the Customer Sample and click Delete 
Customer Sample (4). This option is disabled, if the sample is part of an Inspection 
Lot. 

 

 

(5) Click OK (5) to apply all changes of Customer Samples and to close Show all 
Samples dialog. 

(6) Click Cancel (6) to discard all changes of Customer Samples and to close Show all 
Samples dialog. 

5.1.2.10 Remove Converted Parameters 

NMRPT keeps converted experiment parameters as long as the probe is defined as 
current via edprobe in TopSpin. To delete converted parameters manually use Remove 
Converted Parameters entry in File menu. 

  
Figure 5-37: Remove Converted Parameters in menu 

I 
The creation of a Customer Sample needs to be applied to the Sample List by Apply and 
Close button (Figure 5-33 (10)). The same experiments assigned to the original standard 
sample are assigned to the Customer Sample and the Pairings can be added to an 
Inspection Lot on Inspection Lot tab. 

I 
A Customer Sample that is part of an Inspection Lot can not be deleted. The sample-
experiment Pairings have to be removed from Inspection Lots first. The deletion of a 
Customer Sample needs to be applied to the Sample List by Apply and Close button 
(Figure 5-33 (10)).  
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On the Edit menu shown in Figure 5-37 (1), click Remove Converted Parameters (2) to 
open Remove converted Parameters dialog. 

 

 

Remove converted Parameters Dialog (Figure 5-38) 

 
Figure 5-38: Remove Converted Parameters 

(1) Enter part of an experiment name to the filter bar (1) to list only experiments 
containing this pattern. 

(2) Select an experiment (2) for which to delete the converted parameters. To select 
multiple experiments, press and hold down CTRL, and then click each item. 

(3) Click OK (3) to continue to remove the selected converted parameters. 

(4) Click Cancel (4) to abort removing converted parameters. 

5.1.2.11 Configuration 

In NMRPT Configuration window global settings are located to configure general options 
for sample change behavior and the location of the Acquisition Bar. 

  
Figure 5-39: Configuration in menu 

On the Edit menu shown in Figure 5-39 (1), click Configuration (2) to open NMRPT 
Configuration dialog. 

I The edprobe command is part of TopSpin. Further information is provided in the 
TopSpin manuals (see chapter 1.5 Referenced Documents). 
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Configuration Dialog (Figure 5-40) 

 
Figure 5-40: Configuration dialog 

(1) Use Sample Changer 
Select the useage of a Sample Changer (1). As a default the option is selected if a 
Sample Changer is detected. If no Sample Changer is recognized, the Use Sample 
Changer option is automatically deselected. 

(2) Ignore samples with option “Pause before Change”  
Select this option to set a time span (see (6)) in which to skip experiments on 
samples with option “Pause before Change”. The experiments will remain enqueued. 

(3) Detach Acquisition Bar 
Select this option to detach NMRPT Acquisition Bar from NMRPT main window as a 
space-saving option especially for small screens. 

(4) Wait after sample change for temperature equilibrium [1…600s] 
Select this option to wait for temperature equilibrium in the sample after insert into 
the magnet and before starting the experiment. The waiting time is provided in 
seconds (see (7)). 

(5) Number of holder positions 
The Number of holder positions (5) of a sample changer is automatically set if 
available. Enter the number of holders to set it manually. This box is disabled if (1) is 
deselected. 

(6) Enter a time span (6) for Ignore samples with option „Pause before 
Change“ (see(2)). This box is disabled if (2) is deselected. 

(7) Enter a number between 1 s and the maximum of 600 s for Wait after sample 
change for temperature equilibrium option (see (4)). This box is disabled if (4) is 
deselected. 

(8) Change time format 
Click the dropdown menu (8) to change the time format of the results table in the 
results tab. 

(9) Reload 
Click Reload (8) to revert all changes not applied yet. 

(10) Apply and Close 
Click Apply and Close (9) to save all recent modifications and close Configuration 
dialog. 

(11) Click Close (10) to close Configuration dialog without applying recent modifications. 
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5.1.3 Help 

In Help menu section access to the NMRPT manuals is located. Further information 
about the NMRPT software version is provided. 

 
Figure 5-41: Help menu 

5.1.3.2 NMR Product Test Graphical User Interface Manual 

On the Help menu shown in Figure 5-41 (1), click NMR Product Test Graphical User 
Interface Manual (2) to access this document (ZHUB0002). The Graphical User Interface 
Manual provides detailed information about the NMRPT user interface. 

5.1.3.3 NMR Product Test Experiment Manual 

On the Help menu shown in Figure 5-41 (1), click NMR Product Test Experiment 
Manual (3) to access the Bruker Test Procedures for Avance NMR Systems (see chapter 
1.5 Referenced Documents, ZUEP0102). The Product Test Experiment Manual provides 
detailed information about the NMRPT set of experiments, including example parameters, 
available options and sample plots. 

5.1.3.4 NMR Product Test Short Guide 

On the Help menu shown in Figure 5-41 (1), click NMR Product Test Short Guide (4) to 
access the NMRPT Short Guide. The Short Guide provides basic information and a basic 
standard workflow in NMRPT. 

5.1.3.5 NMR Product Test Release Letter 

On the Help menu shown in Figure 5-41 (1), click NMR Product Test Release Letter (5) 
to access the NMRPT Release Letter. The Release Letter provides changes in the 
NMRPT software since last software release. 
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5.1.3.6 About 

On the Help menu shown in Figure 5-41 (1), click About (6) to access information about 
the current NMRPT version and the TopSpin version in which NMRPT is integrated (see 
Figure 5-42). 

 
Figure 5-42: NMRPT About information 
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5.2 Acquisition Bar 

The control to operate an assembled Experiment Queue and essential information about 
this queue are provided in Acquisition Bar. 

 
Figure 5-43: Acquisition Bar 

(1) Installed Probe 
Installed Probe information (Figure 5-43 (1)) shows the description of the currently 
installed probe as provided by edprobe in TopSpin. 

 

 

(2) Current Experiment 
The Current Experiment information (Figure 5-43 (2)) shows the name of the 
experiment which is currently in progress. This experiment is not listed in Experiment 
Queue anymore. Click the information field to open the experiment in TopSpin 
window. 

(3) Next Experiment 
Next Experiment information (Figure 5-43 (3)) shows the name of the upcoming 
experiment. This experiment is also listed at the top of the Experiment Queue. 

(4) Start  
Click Start (Figure 5-43 (4)) to start the queue of experiments as listed in Experiment 
Queue. If the acquisition of the queue is interrupted either by Stop or Pause button, 
click Start to continue with the next experiment enqueued (including sample change 
if required). 
The Startup Check window (Figure 5-47) appears if a queue is started for the first 
time or restarted after Stop (Figure 5-43 (6)) was applied. 

(5) Pause  
Click Pause (Figure 5-43 (5)) to complete the current experiment and interrupt the 
queue afterwards. If the upcoming experiment requires to change the sample, the 
queue is interrupted before sample change. The upcoming experiment stays 
enqueued. 

(6) Stop  
Click Stop (Figure 5-43 (6)) to stop immediately, independent of the current status 
(7). If acquisition was running Stop aborts the current experiment. The acquisition of 
the experiment is not completed, no evaluable data will be available. The experiment 
is not automatically re-enqueued. The spectrometer may remain in an undefined 
state. 

 

i The edprobe command is part of TopSpin. Further information is provided in the 
TopSpin manuals (see chapter 1.5 Referenced Documents). 

i A running queue (all status except for Stopped) blocks several commands, e.g. closing 
NMRPT and multiple TopSpin commands. 
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(7) Status 
The Status information (Figure 5-43 (7)) provides the current status of NMRPT 
respectively the status of the current experiment queue. Possible status indicators 
are listed in Table 5-1. 

 

Message Explanation 

Waiting green, static – Queue active: Experiment Queue 
empty, NMRPT waiting for the next experiment to 
be enqueued. 

Acquisition in progress 
Processing in progress 
Locksetting in progress 
Cooldown in progress 
Inserting correct sample 
Waiting for temp. equilibrium 

green, flashing – Queue active: Current experiment 
of Queue in progress. The message provides 
further information about the current process. 

Paused 
 

orange, static – Queue paused: Experiment Queue 
manually paused. Click Start button to continue 
Experiment Queue with upcoming experiment, 
including sample change if required. 

Pause before acquisition 
Pause before sample change 

orange, flashing – Queue paused: Experiment 
Queue paused automatically by NMRPT option 
Pause before Acquisition or Pause before Change. 
Click Start button to continue. 

Stopped Red, static – Queue stopped: Experiment Queue 
was stopped immediately, independent of the 
current status (7). If an experiment was currently 
executed it was aborted and dropped from queue. 
Spectrometer might be in an undefined state. Start 
handles remaining experiments like a new queue. 

Table 5-1: Status indicators in NMRPT Acquisition Bar 

(8) Last Message 
Last Message information (Figure 5-43 (8)) shows individual messages from 
experiments. Each message is shown until the next message appears. 

Probe dependent options 

Skip Cooldown (CryoProbe and Prodigy only)  

 
Figure 5-44: Skip Cooldown 

The Skip Cooldown option can be used in case that the connection to the cooling unit is 
broken or a special debugging is necessary. 
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MAS Off Timer (CMP, HRMAS and MAS Probe only)  

 
Figure 5-45: MAS Off Timer 

The MAS off timer automatically stops the MAS spinning when no experiment is running.  

(1) Set timer is used to define the time (in minutes) between last experiment and 
switching MAS spinning off. Default time after NMRPT start is 5 minutes. 

 
Figure 5-46: Set Timer dialog 

Startup Check Dialog (Figure 5-47)  

The Startup Check dialog shows information about the status of mandatory preparation 
steps and settings. It includes reminders and provides access to most of these settings. A 
green checkmark  indicates a successful check of an option. A yellow exclamation 
mark  markes a reminder not checked automatically. A red error sign  indicates a 
mandatory preparation step or setting not met yet.  

 
Figure 5-47: Startup Check dialog 

(1) Set correct field value manually / Set correct field value manually or execute 
NPT_prep_tsopt or NPT_prep_fieldsetting_d as first experiment 
This message reminds to set the correct field value manually. If the experiment 
NPT_prep_tsopt is available for the current Inspection Lot it can be enqueued to set 
the field automatically. 

(2) Ensure sample holder positions correspond to sample list  
(visible if sample changer is set to be used) 
Click Sample List (2) to check if all sample holder positions in Sample List 
correspond to the real holder positions in the sample changer. Holder position 0 
means manual change of the sample. 

(3) Ensure filling of prosol  
Click edprosol (3) to check if all needed 90 degree pulses for the actual probe are 
filled in prosol. 
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(4) Write nmrpt base shim file for probe 
Click wsh (4) to write a base shim file for current probe. 

(5) Recommended Flow at Standard Condition (Edprobe) 
(visible if gas flow is controlled by BSVT) 
Click Edprobe (5) to set Recommended Flow in TopSpin edprobe dialog. 

(6) Maximum Sample Rotation Frequency (Edprobe) 
(visible for MAS / HRMAS probes) 
Click Edprobe (6) to set Maximum Rotation Frequency in TopSpin edprobe dialog. 
This setting is only available for MAS / HRMAS probes. 

 

 

(-) Ensure correct gas flow and temperature settings 
(visible if no BSVT is available) 
Ensure correct temperature and gas flow are applied before starting the Queue. 

(7) First sample in the magnet (manual sample change) 
Select this option (7) to skip sample change process if the correct sample for the 
next experiment is already inside the magnet. 
Current Holder Position (sample changer) 
Shows the current holder position at magnet bore. A negative number indicates an 
unknown state. 

(8) Do Locksetting after sample change  
(visible if lock is available) 
Select this option (8) to execute automatic locksettings after each sample change. 
This option is missing if no lock is available. 

(9) Click OK to confirm all mandatory preparation steps and settings listed in Startup 
Check dialog and to start the queue by acquisition of the first experiment. 

(10) Click Cancel to abort starting the queue. 

 

 

5.3 Navigation 

The Navigation panel on the left in NMRPT window is structured into the main sections 
Probes (Figure 5-48 (1)) and Reports (Figure 5-48 (2)). Both sections are devided into 
individual subnavigations. Expand either Probes or Reports navigation item to access 
thes corresponding subnavigation. Context menus for the Navigation entries provide 
short access to operations also provided in Edit menu. 

i 
The write shim command wsh and the edprobe command are part of TopSpin. Further 
information is provided in the TopSpin manuals (see chapter 1.5 Referenced 
Documents). 

i The OK button (9) of Startup Check dialog is disabled if mandatory preparation steps or 
settings are not met. 
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Figure 5-48: Navigation 

5.3.1 Navigation: Probes 

(2) Probe  
Click a Probe item (Figure 5-48 (2)) to open the corresponding Probe Setup Tab in 
Workspace. Each probe item is named by its Probe ID, a unique identifier composed 
of part and serial number of the probe. 

(3) Test Mode 
Expand a Probe item (2) to access the subordinated Test Mode navigation items 
(Figure 5-48 (3)). These items provide grouping of the Inspection Lots of a probe 
according to their Test Mode (Final Test, Acceptance Test, Field Service Test). 

(4) Inspection Lot  
Expand a Test Mode item (3) to access the subordinated Inspection Lot items 
(Figure 5-48 (4)). Click an Inspection Lot item open the corresponding Inspection Lot 
Tab in Workspace. Inspection Lot navigation items are listed by their name. 

(5) Results  
Expand an Inspection Lot item (4) to access its Result item. Click the Result item 
(Figure 5-48 (5)) to open the corresponding Results Tab in Workspace. Result 
navigation items are listed by the Inspection Lot name.  

Finalized Entries        
Navigation items for Inspection Lots and Results show a green checkmark when 
finalized. Inspections Lots are finalized if the results are used by a finalized report. 

5.3.2 Navigation: Reports 

(7) Test Mode 
The Test Mode navigation items (Figure 5-48 (7)) provide grouping of the Report 
Types in each Test Mode (Final Test, Acceptance Test, Field Service Test). 

(8) Report Type 
Expand a Test Mode item (7) to access the subordinated Report Type navigation 
items (Figure 5-48 (8)). These items provide grouping of the reports. 

(9) Report   
Expand a Report Type item (8) to access the subordinated Report items 
(Figure 5-48 (9)). Click a Report item to open the corresponding Report Tab in 
Workspace. Report navigation items are listed by their name. 
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Finalized Entries  
Navigation entries for reports show a green checkmark when finalized. 

5.3.3 Navigation Context Menus 

Probe Context Menu  (Figure 5-49) 

Right-click the probe item to edit in Navigation panel. The context menu for this probe 
opens up. 

 
Figure 5-49: Navigation context menu – probe 

(1) Delete Probe 
Click Delete Probe (1) in probe context menu to delete the selected probe. A 
subsequent confirmation dialog opens up (Figure 5-50).  

 
Figure 5-50: Navigation context menu – Delete Probe confirmation dialog 

Click OK (Figure 5-50 (1)) to confirm and continue the deletion of the probe. Click 
Cancel (Figure 5-50 (2)) to abort and keep the probe in NMRPT. 
If a probe is deleted from NMRPT, all Inspection Lots, results and measurement data 
of this probe are deleted. Deletion of a probe is not possible if reports are based on 
at least one Inspection Lot of the probe. These reports need to be deleted first. 

Inspection Lot Context Menu  (Figure 5-51) 
Right-click the Inspection Lot item to edit in Navigation panel. The context menu for this 
Inspection Lot opens up. 

 
Figure 5-51: Navigation context menu – Inspection Lot 
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(1) Delete Inspection Lot 
Click Delete Inspection Lot (1) in Inspection Lot context menu to delete the 
selected Inspection Lot. A subsequent confirmation dialog opens up (Figure 5-52).  

 
Figure 5-52: Navigation context menu – Delete Inspection Lot confirmation dialog 

Click OK (Figure 5-52 (1)) to confirm and continue the deletion of the Inspection Lot. 
Click Cancel (Figure 5-52 (2)) to abort and keep the Inspectinon Lot.  
If an Inspection Lot is deleted from NMRPT, all results and measurement data of this 
Inspection Lot are deleted. Deletion of an Inspection Lot is not possible if a report 
based on the Inspection Lot exists. The report needs to be deleted first. 

(2) Copy Inspection Lot 
In Inspection Lot context menu click Copy Inspection Lot (2) to copy an Inspection 
Lot including its experiment specifications to a new one. The new Inspection Lot can 
be assigned to a different Test Mode. This way, e.g. specifications of an Acceptance 
Test can be applied to a Service Test. No experiment data and results will be copied. 
A subsequent dialog (Figure 5-53) opens up.  

 
Figure 5-53: Navigation context menu – Copy Inspection Lot dialog 

Select the Test Mode (Figure 5-53 (1)) for the copy. Enter an individual Name of 
Copy (Figure 5-53 (2)) (see chapter 2.2, permitted characters). The source name 
supplemented with “_Copy” is suggested as a default (see Figure 5-53). Click OK 
(Figure 5-53 (3)) to confirm and finish the copy process. Click Cancel 
(Figure 5-53 (4)) to abort copying the Inspection Lot. 

(3) Rename Inspection Lot 
Click Rename Inspection Lot (3) in Inspection Lot context menu to rename the 
selected Inspection Lot. A subsequent dialog (Figure 5-54) opens up. 

 
Figure 5-54: Navigation context menu – Rename Inspection Lot dialog 

Enter an individual New Name for Inspection Lot (Figure 5-54 (1)) (see chapter 
2.2, permitted characters). The old name is suggested as a default (see 
Figure 5-54). Click OK (Figure 5-54 (2)) to finish renaming the Inspection Lot. Click 
Cancel (Figure 5-54 (3)) to abort renaming the Inspection Lot. 

(4) Rename Plugin (Inspection Lots including plugins only)  
In Inspection Lot context menu click Rename Plugin (4) to correct the part or serial 
number of the plugin connected with the selected Inspection Lot. Subsequent 
dialogs (Figure 5-55) open up. 
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Figure 5-55: Navigation context menu – Rename Plugin dialog, New Plugin Part No 

Enter the New Plugin Part No (Figure 5-55 (1)) (see chapter 2.2, permitted 
characters). The old Part No is suggested as a default. Click OK (Figure 5-55 (2)) to 
continue to rename the plugin. The subsequent dialog shown in Figure 5-56 opens. 
Click Cancel (Figure 5-55 (3)) to abort renaming a plugin. 

 
Figure 5-56: Navigation context menu – Rename Plugin dialog, New Plugin Serial No 

Enter the New Plugin Serial No (Figure 5-56 (1)) (see chapter 2.2, permitted 
characters). The old Serial No is suggested as a default. Click OK (Figure 5-56 (2)) 
to confirm and finish renaming the plugin. Click Cancel (Figure 5-56 (3)) to abort 
renaming the plugin. 
The Rename Plugin menu item is only available for Inspection Lots including plugins. 

Report Context Menu  (Figure 5-57) 

Right-click the report item to edit in Navigation panel. The context menu for this report 
opens up. 

 
Figure 5-57: Navigation context menu – report 

(1) Delete Report 
Click Delete Report (1) in report context menu to delete the selected report. A 
subsequent confirmation dialog opens up (Figure 5-58).  

 
Figure 5-58: Navigation context menu – Delete Report confirmation dialog 

Click OK (Figure 5-58 (1)) to confirm and continue the deletion of the report. Click 
Cancel (Figure 5-58 (2)) to abort the deletion of the report. Deleting a report makes 
the corresponding Inspection Lot available again. It can be changed or deleted. 
Deleting all reports of one probe allows deleting the probe from NMRPT. 
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(2) Rename Report 
Click Rename Report (2) in report context menu to rename the selected report. A 
subsequent dialog (Figure 5-59) opens up. 

 
Figure 5-59: Navigation context menu – Rename Report dialog 

Enter an individual New Name for Report (Figure 5-59 (1)) (see chapter 2.2, 
permitted characters). The old name is suggested as a default (see Figure 5-59). 
Click OK (Figure 5-59 (2)) to finish renaming the report. Click Cancel 
(Figure 5-59 (3)) to abort renaming the report. 
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5.4 Workspace 

In Workspace area of NMRPT main window (Figure 5-60) multiple tabs for different 
functionalities can be accessed: 

• Acquisition tab 
• Probe Setup tab 
• Inspection Lot tab 
• Results tab 
• Report tab 

 

 
Figure 5-60: Workspace area 

 

Click the corresponding item in Navigation panel to open a tab. 

To close a tab, click the x symbol (Figure 5-60 (1)) on the right of its title. 

Change the order of open tabs by drag and drop: Click and hold the title of a tab and 
move it to its new position. 

 

 
  

i The Acquisition tab is unique and only available for the Inspection Lot currently selected 
(see 5.4.3 Acquisition Tab). It can not be closed. 
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5.4.1 Inspection Lot Tab 

On Inspection Lot tab (Figure 5-61), the content of the Inspection Lot is prepared. 
Pairings of experiments and samples are included to the Inspection Lot and their 
specification values are set. The Inspection Lot tab consists of three tables: 

(1) Experiments 
(2) Samples 
(3) Specifications 

 
Figure 5-61: Inspection Lot tab – overview 

(1) Select an experiment from the experiment table (Figure 5-61 (1)) to show the 
respective samples in table (2) (Figure 5-61). The experiment table contains all 
experiments suitable for the probe of the Inspection Lot. 

(2) Select a sample for the selected experiment from the sample table (Figure 5-61 (2)) 
to show the respective specification values in table (3) (Figure 5-61). 
Click Add to List (Figure 5-61 (6)) to add the Pairing of experiment and sample to 
the Inspection Lot. 

(3) Click a cell in Current Specs column of the specification table (Figure 5-61 (3)) and 
enter a specification value. In case of changed Specs, enter Reasons for 
Specification Change to the corresponding cell. Click Save (Figure 5-61 (9)) to 
apply the changes. 

 

 

  

i 
A Specs value of -1 means determination of results, but no comparing evaluation of 
results against specifications. It is mandatory to enter a comment if Delivered Specs are 
available and Current Specs are changed. The results in spectra PDF are marked 
accordingly. Only positive values can be set  as Specs. 
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(4) Select Choose Experiment to Sample to swap the order of experiment table 
(Figure 5-61 (1)) and sample table (Figure 5-61 (2)). Selecting a sample in first table 
shows all experiments available for this sample in second table. Select Choose 
Sample to Experiment to switch back to default order. 

(5) Filter Bar 
Enter an Experiment Name or select a Nucleus of Interest to filter the experiment 
table content. Click Clear Filter to reset filter conditions and to show the unfiltered 
experiment table. 

 

 

(6) Add to List 
Click Add to List (Figure 5-61 (6)) to add the selected Pairing of experiment and 
sample to the list of experiments to be executed, collated in this Inspection Lot. 

(7) Remove from List 
Click Remove from List (Figure 5-61 (7)) to remove the selected Pairing of 
experiment and sample from the list of experiments to be executed, collated in this 
Inspection Lot. 

 

 

(8) Reload 
Click Reload (Figure 5-61 (8)) to revert all changes not applied yet. 

(9) Save 
Click Save (Figure 5-61 (9)) to apply all changes. Changed specifications are also 
applied to experiments of the Inspection Lot already acquired. The experiments are 
reprocessed and evaluated against the new specification value. Therefore the status 
of the results might change. Experiments removed from the Inspection Lot are also 
removed from the Results tab. The measurement data is not deleted. 

(10) Overview 
Click Overview (Figure 5-61 (9)) to open Overview dialog (Figure 5-62). 

 
Figure 5-62: Inspection Lot tab – Overview dialog 

In Overview dialog (Figure 5-62) the experiments currently selected for the 
Inspection Lot are listed. Expand an experiment item (1) to see its specification 
values. Click Close (Figure 5-62 (2)) to close the dialog. 

  

i The Nucleus of Interest is the nucleus in focus of the experiment. The main result of the 
experiment is determined for this nucleus . 

i Experiments removed from an Inspection Lot are also removed from the Results tab if 
already executed. The measurement data is not deleted. The results will be shown again 
in Results tab if the experiments are again added to the Inspection Lot. 
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5.4.2 Probe Setup Tab 

The Probe Setup tab (Figure 5-63) offers global settings for a specific probe. These 
settings are applied as defaults for all future experiments of Inspection Lots for this probe. 

 

 

 
Figure 5-63: Probe Setup tab – overview 

(1) Default Shim Method 
Select the Shim Method from the list (Figure 5-63 (1)) to be set as default for the 
probe. If None is selected as a default, NMRPT Shim Command Number 999 (skip 
shimming) is set as a default for experiments. 

(2) Maximum Shim Order (not HRMAS, MAS, CMP probes)  
Select a Max. 2H On-Axis Order and a Max. Proton On-Axis Order from the 
corresponding lists (Figure 5-63 (2)). These maximum orders are applied according 
to the TopShim ordmax parameter. 

(3) Z-Shim Correction (not MAS, SOL probes)  
Enter a value for Z- or Z2-Shim Correction (Figure 5-63 (3)) to be applied for this 
probe. The correction is applied at the end of the shimming process during water 
suppression experiments. If NMRPT Shim Command 999 (skip shimming) is 
selected for an experiment, Z-Shim Correction is not applied. 

(4) Standard Temperature [K]  
Enter a Standard Temperature (Figure 5-63 (4)) in Kelvin to be applied if 
Temperature und Flow settings (Figure 5-63 (8)) are active. 

(5) Recommended Flow from PICS [l/h]  
This information shows the PICS value for Recommended Flow (Figure 5-63 (5)) in 
litre per hour to be applied if Temperature und Flow settings (Figure 5-63 (8)) are 
selected. 

(6) Sample Depth [mm] (Figure 5-63 (6)) (HR probes only)  
Recomanded Sample Depth below magnetic centre in millimeters for all standard 
samples. 

i The default settings in Probe Setup tab can be changed for each experiment individually 
in Preparation panel of the Acquisition tab. 
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Sample Depth Solvent Suppression in millimeters for best solvent suppression 
results. 
This information shows the PICS values for Sample Depth. 

(7) Write nmrpt base shim file for probe 
Click wsh (Figure 5-63 (7)) to write a base shim file. 

(8) Skip Temperature Setting 
Select this option (Figure 5-63 (8)) to skip setting the Standard Temperature of the 
probe to temperature control unit. 

(9) Skip Gas Flow Setting 
Select this option (Figure 5-63 (9)) to skip setting the gas flow for temperature 
control by NMRPT. Experiments that require a defined flow will become irregular. 
This option is disabled if temperature control unit is set to external mode. 

(10) Skip Lock (probes with 2H only)  
Select Skip Lock option (Figure 5-63 (10)) to measure the experiment unlocked or 
to lock manually. This option is missing if no lock is available. 

(11) Skip Tuning/Matching 
Select this option (Figure 5-63 (11)) to skip tuning and matching of all nuclei used in 
an experiment. If selected, Skip XNUC Tuning/Matching (Figure 5-63 (12)) and 
Skip HNUC Tuning/Matching (Figure 5-63 (13)) are disabled. 

(12) Skip XNUC Tuning/Matching 
Select this option (Figure 5-63 (12)) to skip tuning and matching of all X nuclei used 
in an experiment. This option is disabled if Skip Tuning/Matching (Figure 5-63 (11)) 
is selected. 

(13) Skip HNUC Tuning/Matching  
Select this option (Figure 5-63 (13)) to skip tuning and matching of the H nucleus if 
used in an experiment. This option is disabled if Skip Tuning/Matching 
(Figure 5-63 (11)) is selected. 

(14) Apply 
Click Apply (Figure 5-63 (14)) to apply all settings as defaults for future experiments 
set up for this probe. 

(15) Reload 
Click Reload (Figure 5-63 (15)) to revert all changes not applied yet. 

 

 
  

i 
NMRPT Shim Commands encompass sequences of combined TopSpin and TopShim 
commands. Maximum Shim Order is applied to these NMRPT Shimcommands and 
therefore the complete sequence included. More Information about NMRPT Shim Com-
mands is provided in chapter 4.4 NMRPT Shim Handling. General information about 
shimming in TopSpin and the write shim command wsh are provided in the TopSpin and 
TopShim manuals (see chapter 1.5 Referenced Documents). 
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5.4.3 Acquisition Tab 

The Acquisition tab (Figure 5-64) is devided into three main areas: 

(1) Library 
(2) Experiment Preparation 
(3) Experiment Queue 

 
Figure 5-64: Acquisition tab – overview 

 

 

Select Inspection Lot (Figure 5-64 (4))  
On the Acquisition tab (Figure 5-64) click Select Inspection Lot (4). The Select 
Inspection Lot dialog opens. 

 
Figure 5-65: Acquisition tab – Select Inspection Lot dialog 

Select the Inspection Lot to measure from the list in the dialog window shown in 
Figure 5-65. Click OK (Figure 5-65 (1)) to apply the selection. Click Cancel 
(Figure 5-65 (2)) to abort selecting an Inspection Lot for acquisition. 

  

i Experiments in Acquisition tab can also be moved from Experiment Preparation to 
Experiment Queue and back – or inside these lists, using drag and drop. Click and hold 
an experiment item and move it to the new position. 
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Library (Figure 5-64 (1))  
In the Library all experiments of the current Inspection Lot are listed grouped by the 
samples of the Pairing. Expand a sample entry to access the corresponding experiments. 
Click the check box in front of an experiment to select experiments individually. 

(7) Recommended Experiment Sequence  
Select Recommended Experiment Sequence (7) from Library to select all 
experiments from Library in recommended measurement order. The Reommended 
Experiment Sequence contains all experiments listed below, grouped by sample. 

(8) Remove tick after adding  
Select Remove tick after adding (8) to automatically deselect experiments in 
Library when added to the Experiment Preparation or Experiment Queue. 

(6) Exp. Missing in Report 
Click Exp. Missing in Report (6) to show a list of experiments (Figure 5-66) of the 
Inspection Lot not measured yet. Only experiments for current routing and samples 
currently available are listed. 

 
Figure 5-66: Acquisition tab – Exp. Missing in Report dialog 

Select experiments from the list (Figure 5-66) and click Add to Preparation Table 
(Figure 5-66 (1)) to move the experiments to the table for Experiment Preparation. 
Click Add to Queue (Figure 5-66 (2)) to add the experiments directly to the 
Experiment Queue. Click Close (Figure 5-66 (3)) to close the dialog. 

(5) Exp. Failed in Report 
Click Exp. Failed in Report (5) to show a list of experiment runs set to be used for 
report (Figure 5-67) that do not meet specifications. Only experiments for current 
routing and samples currently available are listed. 

 
Figure 5-67: Acquisition tab – Failed Exp. in Report 

Select experiments from the list (Figure 5-67) and click Add to Preparation Table 
(Figure 5-67 (1)) to move the experiments to the table for Experiment Preparation. 
Click Add to Queue (Figure 5-67 (2)) to add the experiments directly to the 
Experiment Queue. Click Close (Figure 5-67 (3)) to close the dialog. 
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Experiment Preparation – Workflow (Figure 5-68)  

The Experiment Preparation panel provides individual settings for experiments. Therefore 
select an experiment in the table for Experiment Preparation (7) and modify the settings 
below (24). 

 
Figure 5-68: Acquisition tab – detail: Experiment Preparation (Figure 5-64 (2)), workflow 

(1) Add 
Select experiments in Library (Figure 5-64 (1)) and click Add (1) to move these 
experiments to Experiment Preparation table (7). 

(2) Remove 
Select experiments in Experiment Preparation table (7) and click Remove (2) to 
remove these experiments from Experiment Preparation table (7). 

(3) Remove All 
Click Remove All (3) to remove all experiments from Experiment Preparation table 
(7). 

(4) Move Up 
Select an experiment in Experiment Preparation table (7) and click Move Up (4) to 
move the experiment up in the table. A higher position in the table means an earlier 
acquisition in the Experiment Queue (Figure 5-64 (3)). 

(5) Move Down 
Select an experiment in Experiment Preparation table (7) and click Move Down (5) 
to move the experiment down in the table. A lower position in the table means a later 
acquisition in the Experiment Queue (Figure 5-64 (3)). 

(6) Add to Queue 
Cilck Add to Queue (6) to add selected experiments from Library (Figure 5-64 (1)) 
directly to the Experiment Queue (Figure 5-64 (3)). This skips the Experiment 
Preparation step. The measurement order is based on the Recommended 
Experiment Sequence (Figure 5-64 (8)). 

(8) Submit 
Select experiments in Experiment Preparation table (7) and click Submit (8) to move 
the experiments to Experiment Queue (Figure 5-64 (3)). 

(9) Submit All  
Click Submit All (9) to move all experiments in Preparation table (7) to Experiment 
Queue (Figure 5-64 (3)). 
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(10) Edit 
Select the experiments to edit in Experiment Queue (Figure 5-64 (3)). Click Edit (10) 
to move the experiments to Experiment Preparation table (7) to change settings or 
measurement order. 

(11) Edit All 
Click Edit All (11) to move all experiments from Experiment Queue (Figure 5-64 (3)) 
to Experiment Preparation table (7) to change settings or measurement order. 

(12) Remove 
Select the experiments to be removed in Experiment Queue (Figure 5-64 (3)). Click 
Remove (12) to remove the experiments from the Queue. 

(13) Remove All 
Click Remove All (13) to remove all experiments from Experiment Queue 
(Figure 5-64 (3)). 

Experiment Preparation – Detail Settings (Figure 5-69) 
 

 
Figure 5-69: Acquisition tab – detail: Experiment Preparation (Figure 4 47 (2)), detail settings 

(1) Skip Tuning/Matching 
Select this option (1) to skip tuning and matching of all nuclei used in the experiment. 
If selected, Skip XNUC Tuning/Matching (2) and Skip HNUC Tuning/Matching (3) 
are disabled. 

(2) Skip XNUC Tuning/Matching 
Select Skip XNUC Tuning/Matching (2) to skip tuning and matching of all X nuclei 
used in the experiment. This option is disabled if Skip Tuning/Matching (1) is 
selected. 

(3) Skip HNUC Tuning/Matching  
Select Skip HNUC Tuning/Matching (3) to skip tuning and matching of the H 
nucleus if used in the experiment. This option is disabled if Skip Tuning/Matching 
(1) is selected. 

(4) Generate Shim Plot 
Select Generate Shim Plot (4) to add a shim plot to the results of the experiments. 

(5) Reduce ordmax according to probe setting (not HRMAS, MAS, CMP probes)  
Select Reduce ordmax according to probe setting (5) to apply the settings for 
maximum shim order which were set for the probe in Probe Setup tab. 
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(6) Skip Getprosol 
Select Skip Getprosol (6) to skip setting pulses applying the TopSpin getprosol 
command for the experiment. 

 

 

(7) Skip Temperature Setting 
Select Skip Temperature Setting (7) to skip setting the Standard Temperature of 
the probe, as defined on Probe Setup tab, to temperature control unit. 

(8) Skip Gas Flow Setting 
Select this option (8) to skip setting the gas flow for temperature control by NMRPT. 
Experiments that require a defined flow will become irregular. This option is disabled 
if temperature control unit is set to external mode. 

(9) Skip Lock 
Select Skip Lock (9) to measure the experiment unlocked or to lock manually. This 
option is missing if no lock is available. 

(10) Shim Command / Select Shim Command 
Select a Shim Command number from the list (10) to select a shim sequence to be 
applied for the experiment. Click Select Shim Command (10) to open Select Shim 
Command dialog (Figure 5-70).  

 
Figure 5-70: Acquisition tab – Select Shim Command dialog 

Select a Shim Command from the list and click Select (1) to apply the Shim 
Command to the experiment. Click Cancel (2) to abort changing the Shim 
Command. 

(11) TopSpin Experiment Parameters 
Edit specific TopSpin experiment parameters 

  

i 
If Skip Getprosol is selected, pulse determination experiments also skip writing the 
determined pulses to the prosol tables (setprosol). 
The getprosol and setprosol commands are part of TopSpin. Further information is 
provided in the TopSpin manuals (see chapter 1.5 Referenced Documents). 
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Experiment Queue (Figure 5-71)  

The Experiment Queue (Figure 5-64 (3)) shows the sequence of experiments in mea-
surement order. The experiment listed in first line will be executed next. To change the 
order of the sequence, see Experiment Preparation. 

 
Figure 5-71: Acquisition tab – detail: Experiment Queue (Figure 5-64 (3)) 

(1) Pause before Acquisition 
Select experiments in Experiment Queue (Figure 5-64 (3)) and click  to pause the 
queue before the acquisition of the selected experiments. If a sample change is 
required, the Experiment Queue is paused after sample change (unlike the sample 
specific Pause before Change option available from Sample List). 

(2) Run Experiment without Pause before Acquisition 
Select experiments in Experiment Queue (Figure 5-64 (3)) and click  to pause the 
queue before the acquisition of the selected experiments. 

(3) Skip Experiment 
Select experiments in Experiment Queue (Figure 5-64 (3)) and click  to skip 
these experiments when doing the acquisition. 

(4) Execute Experiment 
Select experiments in Experiment Queue (Figure 5-64 (3)) and click  to mark 
these experiments for acquisition. 

(5) Execute Tuning/Matching 
Select experiments in Experiment Queue (Figure 5-64 (3)) and click  to execute 
Tuning/Matching during acquisition of the selected experiments. 

(6) Skip Tuning/Matching 
Select experiments in Experiment Queue (Figure 5-64 (3)) and click  to skip 
execution of Tuning/Matching during acquisition of the selected experiments. 

(7) No Rotation 
The rotation will be turned off for all experiments in the Experiment Queue 
(Figure 5-64 (3)) when this checkbox is marked. 
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5.4.4 Results Tab 

The Results tab provides an overview of all experiments executed and their results. It 
offers access to additional information about each run of an experiment and allows 
selecting the run for report. It also offers access to the measurement data in TopSpin and 
provides options for reprocessing of a selected run. The Results tab (Figure 5-72) 
consists of three main areas: 

(1) Results table 
(2) Dataset options 
(3) Processing options 

 

 
Figure 5-72: Results tab – overview 

The button panel of Results tab provides access to information about the current state 
and content of the Inspection Lot:  

(4) Click Short PDF  (Figure 5-72 (4)) to access the Short PDF of this Inspection Lot. 

(5) Experiments Missing in Report 
Click Experiments Missing in Report (Figure 5-72 (5)) to show a list of 
experiments of the Inspection Lot not measured yet (Figure 5-73). Only experiments 
for samples currently available are listed. 
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Figure 5-73: Results tab – Experiments Missing in Report dialog 

Expand experiment items from the List of not measured Experiments 
(Figure 5-73) to show the Current Specs of the experiments. Click Close 
(Figure 5-73 (2)) to close the dialog. 

(6) Failed Experiments in Report 
Click Failed Experiments in Report (Figure 5-72 (6)) to show a list of experiment 
runs set to be used for report (Figure 5-67) that do not meet specifications. Only 
experiments for samples currently available are listed. 

 
Figure 5-74: Results tab – Failed Experiments in Report dialog 

The List of failed Experiments (Figure 5-74 (1)) contains all non-successful 
experiment runs set to be used for report. Non-successful experiments are either 
experiments with status error (red status icon ) or experiments that do not meet 
the specifications (yellow exclamation mark ). Further information about each of 
these experiment runs is provided. Click Close (Figure 5-74 (2)) to close the dialog. 

(7) Additional PDF (of Inspection Lot)  
Click Additional PDF to include additional PDF files (e.g. external measurements 
acquired outside NMRPT) to the Additional Report of the Inspection Lot.  

 
Figure 5-75: Results tab – Additional PDF dialog 

In the subsequent Additional PDF dialog the PDF files to be included are shown in 
List of Additional PDF files (Figure 5-75 (1)). Click Add (Figure 5-75 (2)) to open a 
file browser and to select a PDF file from hard disk. The file is added to the list. Click 
the Comment cell of a file entry in the list to enter a comment if required. Select a 
file list entry and click Edit (Figure 5-75 (3)) to edit an Additional PDF entry.  Select a 
file list entry and click Remove (Figure 5-75 (4)) to remove an Additional PDF file. 
Select a file list entry and click Open (Figure 5-75 (5)) to open an Additional PDF file 
with a PDF viewer. Click Save (Figure 5-75 (6)) to apply all changes and close 
Additional PDF dialog. 
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Results Table (Figure 5-76) 

 
Figure 5-76: Results tab – detail: results table (Figure 5-72 (1)) 

(1) A green icon  in the Status column (1) means no errors occurred and all speci-
fications were achieved. A yellow exclamation mark  indicates that specifications 
were not achieved. A red error icon  is shown if errors occurred during acquisition 
or processing. 

 

 
(2) A report icon  in Report column (2) indicates which run of an experiment is used 

for report. As a default, the last run of each experiment is used if no error (see (1)) 
occurred. 

(3) A report icon  in Additional Report column (2) indicates which run of an 
experiment is selected to be used for Additional Report. 

(4) Select an experiment in results table to see the corresponding specifications and 
results in Specifications table (4). Results not reaching specifications are printed in 
red.  

i More information about each run of an experiment and its status is provided as Additional 
Info (see (6)) 
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Dataset Options (Figure 5-77) 

 
Figure 5-77: Results tab – detail: Dataset options (Figure 5-72 (2)) 

(1) For Report 
Select a run of an experiment in results table (Figure 5-72 (1)) and click For 
Report (1) to select the run to be used for report. A report icon  in the Report 
column of the run indicates the run is used for report. If errors occurred during 
measurement or processing, this option may be disabled. 

(2) Add to Additional Report  
Select a run of an experiment in results table (Figure 5-72 (1)) and click Add to 
Additional Report (2) to add the run of the experiment to the Additional Report. A 
report icon  in the Additional Report column of the run indicates the run is used 
for report. If errors occurred during measurement or processing, this option may be 
disabled. 

(3) Remove from Additional Report  
Select a run of an experiment in results table (Figure 5-72 (1)) and click Remove 
from Additional Report (3) to remove the run of the experiment from the Additional 
Report. This option is only available for runs added to the Additional Report. 

 

 

(4) Show PDF  
Select a run of an experiment in results table (Figure 5-72 (1)) and click Show 
PDF (4) to access the single spectrum PDF of this run. If errors occurred during 
measurement or processing, this option may be disabled. 

(5) Show in TopSpin  
Select a run of an experiment in results table (Figure 5-72 (1)) and click Show in 
TopSpin (5) to access the measurement data of this run in TopSpin window. 

(6) Show Additional Info  
Select a run of an experiment in results table (Figure 5-72 (1)) and click Show 
Additional Info (6) to open Additional Information dialog (Figure 5-78). 

  

i Irregular experiments can not be part of a report but can be added as Additional Report. 
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Figure 5-78: Results tab – Show Additinal Info dialog 

The Show Additional Info dialog (Figure 5-78) provides detailed information about 
All Status (Figure 5-78 (1)) of the run. Separate icons indicate if Acquisition and 
Processing occurred without errors and if the Results match the specifications. A 
fourth icon indicates if the experiment was executed under Regular conditions. 

An overview about the applied NMRPT control Parameters (Figure 5-78 (2)) is 
provided for information. 

Log Messages (Figure 5-78 (3))  are listed to provide detailed information about the 
specific run. Click Show Expert Messages to access more detailed expert 
information.  

Click Close (Figure 5-78 (4)) to close Show Additional Info dialog. 

Processing Options (Figure 5-79)  

 
Figure 5-79: Results tab – detail: Processing options 

(1) Select a run of an experiment in results table (Figure 5-72 (1)), select default (1) and 
click Reprocessing (5) to reprocess the run of the experiment applying the default 
phase correction option for this experiment. (see Experiment Documentation, 1.5 
Referenced Documents)  

(2) Select a run of an experiment in results table (Figure 5-72 (1)), select with PK (2) 
and click Reprocessing (5) to reprocess the run of the experiment applying TopSpin 
PK command.  

(3) Select a run of an experiment in results table (Figure 5-72 (1)), select with APK (3) 
and click Reprocessing (5) to reprocess the run of the experiment applying TopSpin 
APK command.  

(4) Select a run of an experiment in results table (Figure 5-72 (1)), select with APK0 (4) 
and click Reprocessing (5) to reprocess the run of the experiment applying TopSpin 
APK0 command.  

(5) Reprocessing 
Click Reprocessing (5) to start reprocessing the selected experiment applying 
selected processing option. 
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(6) Edit Comment 
Click Edit Comment (6) to edit the comment of selected experiment. Reprocessing 
will be executed afterwards. 
 

5.4.5 Report Tab 

The NMRPT report, consisting of a spectra PDF and the test protocol for signature, is 
created from Report tab. In Report tab all information for a test report is summarized. 
Therefore the content of the tab (Figure 5-80 (1)) depends on the Test Mode and the 
Report Type. The button panel (Figure 5-80 (2)) is the same for all modes and types (see 
individual report tab chapters for detailed information). 

 

 

 
Figure 5-80: Report tab – overview 

 
  

i 
The phase correction commands PK, APK and APK0 are part of TopSpin. Further 
information is provided in the TopSpin manuals (see chapter 1.5 Referenced 
Documents). 

i 
Information for Report Creation 
Enter all available information on Report tab. This information is used to create and fill 
the final document for signature. Empty information may result in an invalid document. 
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5.4.5.1 Report Tab for Acceptance Test  

The Acceptance Test Report tab is devided into different sections. Some sections differ 
depending on the subject to the acceptance. As an example the Acceptance Report tab 
of a probe is shown in Figure 5-81. 

Acceptance Test Report Tab – General Sections (Figure 5-81) 

 
Figure 5-81: Report tab – Acceptance Test Probe 

(1) General Information 
In General Information section (Figure 5-81 (1)) click edcstm to open the Customer / 
System Setup dialog of TopSpin. In this dialog enter at least all information marked 
as required. Save all changes before closing the dialog. 
In Engineer text field of the Report tab (Figure 5-81), enter the name of the engineer 
responsible for the Acceptance Test. Select the Date of Signature from the 
dropdown calendar. Remarks can also be added to the report filling the Remarks / 
Exclusions text field. 

 

 

(2) Probe Information (Probe Report only) 
Enter the Order No. and Contract No. of the tested probe in the text fields of Probe 
Information section (Figure 5-81 (2)). 

i The edcstm command is part of TopSpin. Further information is provided in the TopSpin 
manuals (see chapter 1.5 Referenced Documents). 

1 

2 

3 

4 



GUI-Description 

ZHUB0002 
 

87 

- confidential - 

(2) Accessory Information (Accessories Report only)  

 
Figure 5-82: Report tab – Acceptance Test Accessories, Accessory Information 

Enter the Order No. (Figure 5-82 (1)) and Contract No. (Figure 5-82 (2)) of the 
tested accessories in the text fields of Accessory Information section (Figure 5-82). 
Click Add (Figure 5-82 (3)) to add a new line to the table of accessories that are 
subject to this report. Enter the part (P/N) and serial (S/N) numbers of the tested 
accessories into the corresponding cells. Select a line in the table and click Remove 
(Figure 5-82 (4)) to delete this item. 

(3) Inspection Lot for Report 
In case of a Probe Report, the Inspection Lot Name, the Probe ID and the 
Description are shown in Inspection Lot for Report section (Figure 5-81 (3)) for 
information.  

 
Figure 5-83: Report tab – Acceptance Test Spectrometer/Accessories, Inspection Lot for Report 

In case of Spectrometer and Accessories Reports multiple Inspection Lots can be 
included to a report. The Inspection Lots are listed in a table (Figure 5-83) providing 
the Description, the Probe ID and the Inspection Lot Name in columns. Select an 
Inspection Lot in the table and click Remove and Save (Figure 5-83(2)) to remove 
an Inspection Lot from the report. Click Add and Save (Figure 5-83(1)) to add 
further Inspection Lots. The Add Inspection Lot dialog (Figure 5-84) opens.  

 
Figure 5-84: Report tab – Acceptance Test Spectrometer/Accessories, Add Inspection Lot dialog 

Select the Inspection Lot to add from the list in the dialog and click OK 
(Figure 5-84 (1)) to apply the selection. Click Cancel (Figure 5-84 (1)) to abort 
adding an Inspection Lot to the report. 

 

i Only in case of an Accessories Report a report without any Inspection Lot can be 
created. 
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(4) Additional PDF (of report) 
Additional PDF documents can be included in the report. These documents are 
listed in Additional PDF section (Figure 5-81 (4)) of Report tab. Click Add to open a 
document browser to select files from hard disk. To add a comment to a file, enter 
the text into the cell in Comment column of the PDF list item. Select an Additional 
PDF list item and click Edit to edit the PDF entry. Select an Additional PDF list item 
and click Remove to remove the PDF from report. Select an Additional PDF list item 
and click Open to open the PDF with a PDF viewer. 

Acceptance Test Report Tab – Checklist Sections (Figure 5-85)  
Scroll down to find multiple checklist sections on Acceptance Test Report tab. Select the 
status for each item out of three different options: Pass, Fail and n/a (not applicable). 

 
Figure 5-85: Report tab – Acceptance Test Probe, checklist sections 

• Installation 
In Installation Checklist information about completed installation steps and aspects is 
collected for documentation. In all cases of Acceptance Reports the following items 
are available:  

• All connections and grounding 
• All Firmware 
• Cortab for required nuclei 
• Lift / spin calibration  
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For a Spectrometer Report additional items are:  

• Software licenses 
• He / N2 log files activated 
• MICS installed 

• Training 
In Training Checklist information about the customer training is collected. In all cases 
of Acceptance Reports the following items are available:  

• Basic safety 
• Handling of cryogenic liquids 
• Troubleshooting 
• Backups (nmr_save, images) 
• Introduction to IconNMR 
• Assure-SST / Performance check 

If a CryoProbe is subject to a Probe or Spectrometer Report additional items are: 

• Handling / cleaning of probe 
• He cylinder exchange 
• He compressor cooling, RF heating / power limits 
• RF routing  

In case of a Spectrometer Report further items are: 

• Magnet safety and refilling  
• Hardware overview 
• Console on/off operation 
• Basic operation 

• Acceptance and Warranty 
This checklist collates all information concering acceptance and warranty to be 
provided to the customer:  

• Explanation of warranty  
• Customer support hotlines 

In case of a Spectrometer Report further item is:  

• Spectrometer documentation 

• Optional Components (Probe and Spectrometer Report only)  
In Optional Components Checklist information about optional components being 
subject to the report is collected. Despite a list of suggested components five custom 
fields are provided. Enter further optional components to these custom fields. 

• Sample changer 
• MAS controller 
• High power equipment 
• LC-NMR 
• Liquid Handler SamplePro Tube 
• Micro-Imaging 
• Diffusion 
• CryoProbe, Cryoplatform 
• BNL / BSNL 
• Additional cooling/heating units (like BCU1 / BCU2) 
• LT-MAS (Low Temperature MAS equipment) 
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• Gyrotron magnet and DNP console 
• five custom fields 

Acceptance Test Report Tab – Button Panel (Figure 5-85 ) 

(1) Save 
Click Save (1) to apply all changes to the current report. 

(2) Last Save 
Click Last Save (2) to revert all changes in Report Tab not applied yet. 

(3) Create Protocol & Spectra 
Click Create Protocol & Spectra (3) to create the spectra PDF and the protocol 
PDF of the report. All results set to be used for report and for Additional Report are 
included. Both parts of the report are marked as preliminary until it is finalized. 

(4) Show Protocol 
Click Show Protocol (4) to open protocol PDF file. The protocol PDF is marked as 
preliminary until it is finalized. This button is disabled if no protocol PDF was created 
yet. 

(5) Show Spectra 
Click Show Spectra (5) to open spectra PDF file. The spectra PDF is marked as 
preliminary until it is finalized. This button is disabled if no spectra PDF was created 
yet. 

(6) Finalize (non-finalized reports only)  
Click Finalize (6) to create the final report for signature. The finalized spectra and 
protocol PDF files can not be recreated. Finalizing a report finalizes the Inspection 
Lots and results the report is based on. 

(6) Export (finalized reports only)  
Click Export (6) to open a file browser to export the finalized report to hard disk. 

 

 
  

i 
Finalized means, no further changes to the report, the included Inspection Lots, their 
experiments and results can be done. In the Navigation panel, the corresponding icons 
are signed with a green checkmark. To make an Inspection Lot available again, the 
finalized report has to be deleted first. 
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5.4.5.2 Report Tab for Final Test  

The Final Test Report tab is devided into different sections. Some sections differ 
depending on the subject to the Final Test. As an example the Final Test Report tab of a 
probe is shown in Figure 5-86. 

 
Figure 5-86: Report tab – Final Test Probe 

Final Test Report Tab – General Sections (Figure 5-86) 

(1) General Information 
In General Information section (Figure 5-86 (1)) click edcstm to open the Customer / 
System Setup dialog of TopSpin. In this dialog enter at least all information marked 
as required. Save all changes before closing the dialog. 
In Engineer field of the Report tab (Figure 5-86) enter the name of the engineer 
responsible for the Final Test. Enter the name of the Supervisor in the 
corresponding text field. Also enter the Approval Postal Code, Approval City and 
Approval Country in the corresponding text fileds. Select the Date of Signature 
from the dropdown calendar. Remarks can be added to the report filling the 
Remarks / Exclusions text field. 

 

 

(2) Probe Information (Probe Report only) 
Enter the Order No. of the tested probe in the text field of Probe Information section 
(Figure 5-86 (2)). 

i The edcstm command is part of TopSpin. Further information is provided in the TopSpin 
manuals (see chapter 1.5 Referenced Documents). 
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(2) Accessory Information (Accessories Report only)  

 
Figure 5-87: Report tab – Final Test Accessories, Accessory Information 

Enter the Order No. (Figure 5-87 (1)) and Contract No. (Figure 5-87 (2)) of the 
tested accessories in the text fields of Accessory Information section (Figure 5-87). 
Click Add (Figure 5-87 (3)) to add a new line to the table of accessories that are 
subject to this report. Enter the part (P/N) and serial (S/N) numbers of the tested 
accessories into the corresponding cells. Select a line in the table and click Remove 
(Figure 5-87 (4)) to delete this item. 

(3) Inspection Lot for Report 
In case of a Probe Report, the Inspection Lot Name, the Probe ID and the 
Description are shown in Inspection Lot for Report section (Figure 5-86 (3)) for 
information.  

 
Figure 5-88: Report tab – Final Test Spectrometer/Accessories, Inspection Lot for Report 

In case of Spectrometer and Accessories Reports multiple Inspection Lots can be 
included to a report. The Inspection Lots are listed in a table (Figure 5-88) providing 
the Description, the Probe ID and the Inspection Lot Name in columns. Select an 
Inspection Lot in the table and click Remove and Save (Figure 5-89 (2)) to remove 
the Inspection Lot from the report. Click Add and Save (Figure 5-89 (1)) to add 
further Inspection Lots. The Add Inspection Lot dialog (Figure 5-89) opens up. 

 
Figure 5-89: Report tab – Final Test Spectrometer/Accessories, Add Inspection Lot dialog 

Select the Inspection Lot to add from the list in the dialog and click OK 
(Figure 5-89 (1)) to apply the selection. Click Cancel (Figure 5-89 (1)) to abort 
adding an Inspection Lot to the report. 

 

i Only in case of an Accessory Test a report without any Inspection Lot can be created. 
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(4) Additional PDF (of report) 
Additional PDF documents can be included in the report. These documents are 
listed in Additional PDF section (Figure 5-86 (4)) of Report tab. Click Add to open a 
document browser to select files from the hard disk. To add a comment to a file, 
enter the text into the cell in Comment column of the PDF list item. Select an 
Additional PDF list item and click Remove to remove the PDF from report. 

Final Test Report Tab – Button Panel (Figure 5-86) 

(5) Save 
Click Save (5) to apply all changes to the current report. 

(6) Last Save 
Click Last Save (6) to revert all changes in Report tab not applied yet. 

(7) Create Protocol & Spectra 
Click Create Protocol & Spectra (7) to create the spectra PDF and the protocol 
PDF of the report. All results set to be used for report and for Additional Report are 
included. Both parts of the report are marked as preliminary until it is finalized. 

(8) Show Protocol 
Click Show Protocol (8) to open protocol PDF file. The protocol PDF is marked as 
preliminary until it is finalized. This button is disabled if no protocol PDF was created 
yet. 

(9) Show Spectra 
Click Show Spectra (9) to open spectra PDF file. The spectra PDF is marked as 
preliminary until it is finalized. This button is disabled if no spectra PDF was created 
yet. 

(10) Finalize (non-finalized reports only)  
Click Finalize (10) to create the final report for signature. The finalized spectra and 
protocol PDF files can not be recreated. Finalizing a report finalizes the Inspection 
Lots and results the report is based on.  

(10) Export (finalized reports only)  
Click Export (6) to open a file browser to export the finalized report to hard disk. 
 

 

i 
Finalized means, no further changes to the report, the included Inspection Lots, their 
experiments and results can be done. In the Navigation panel, the corresponding icons 
are signed with a green checkmark. To make an Inspection Lot available again, the 
finalized report has to be deleted first. 
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5.4.5.3 Report Tab for Field Service Test  

 
Figure 5-90: Report tab – Field Service Test Spectrometer 

Field Service Test Report Tab – General Sections (Figure 5-90) 

(1) General Information 
In General Information section (Figure 5-90 (1)) click edcstm to open the Customer / 
System Setup dialog of TopSpin. In this dialog enter at least all information marked 
as required. Save all changes before closing the dialog. 
In Engineer field of the Report tab (Figure 5-90) enter the name of the engineer 
responsible for the Field Service Test. Enter the Service Contract No. and the SAP 
Service Request No. in the corresponding text fileds. Select the Date of Signature 
from the dropdown calendar. Remarks can be added to the report filling the 
Remarks / Exclusions text field. 

 

 
  

i The edcstm command is part of TopSpin. Further information is provided in the TopSpin 
manuals (see chapter 1.5 Referenced Documents). 
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(-) Probe Information (Probe Report only) 

 
Figure 5-91: Report tab – Field Service Test Probe, Probe Information 

Enter the Order No. of the tested probe in the text field of Probe Information section 
(Figure 5-91 (1)). 

(-) Accessory Information (Accessories Report only)  

 
Figure 5-92: Report tab – Field Service Test Accessories, Accessory Information 

Enter the Order No. (Figure 5-92 (1)) and Contract No. (Figure 5-92 (2)) of the 
tested accessories in the text fields of Accessory Information section (Figure 5-92). 
Click Add (Figure 5-92 (3)) to add a new line to the table of accessories that are 
subject to this report. Enter the part (P/N) and serial (S/N) numbers of the tested 
accessories into the corresponding cells. Select a line in the table and click Remove 
(Figure 5-92 (4)) to delete this item. 

(2) Inspection Lot for Report 
In case of Spectrometer and Accessories Reports multiple Inspection Lots can be 
included to a report. The Inspection Lots are listed in a table (Figure 5-90 (2)) 
providing the Description, the Probe ID and the Inspection Lot Name in columns. 
To remove an Inspection Lot from the report, select an Inspection Lot in the table 
and click Remove and Save button in Inspection Lot for Report section 
(Figure 5-90 (2)). Click Add and Save button in Inspection Lot for Report section 
(Figure 5-90 (2)) to add further Inspection Lots. The Add Inspection Lot dialog 
(Figure 5-93) opens.  

 
Figure 5-93: Report tab – Final Test Spectrometer/Accessories, Add Inspection Lot dialog 

Select the Inspection Lot to add from the list in the dialog and click OK 
(Figure 5-93 (1)) to apply the selection. Click Cancel (Figure 5-93 (1)) to abort 
adding an Inspection Lot to the report. 

In case of a Probe Report, the Inspection Lot Name (Figure 5-94 (3)), the Probe ID 
(Figure 5-94 (2)) and the Description (Figure 5-94 (1)) are shown in Inspection Lot 
for Report section for information.  

  

1 

1 
2 

3 4 

1 2 



GUI-Description 

ZHUB0002 
 

96 
 

- confidential - 

 

 
Figure 5-94: Report tab – Final Test Spectrometer/Accessories, Inspection Lot for Report 

  

 

(3) Additional PDF (of report) 
Additional PDF documents can be included in the report. These documents are 
listed in Additional PDF section (Figure 5-90 (3)) of Report tab. Click Add to open a 
document browser to select files from hard disk. To add a comment to a file, enter 
the text into the cell in Comment column of the PDF list item. Select an Additional 
PDF list item and click Remove to remove the PDF from report. 

Field Service Test Report Tab – Checklist Sections (Figure 5-90 (4))  
Scroll down on Field Service Test Report tab to find multiple checklist sections. Select the 
status for each item out of three different options: Pass, Fail and not applicable (n/a). 

• General Components (Spectrometer Report only) 
In General Components Checklist information about general aspects of a Field 
Service Test is collected for documentation:  

• All firmware 
• Software updated 
• Cortab 
• Lift / spin calibration 
• He / N2 log files 
• MICS 
• BSMS 
• AQS chassis 
• Shim system turbine cleaned 
• Door filter(s) replaced 

• Optional Components (Probe and Spectrometer Report only)  
In Optional Components Checklist information about optional components being 
subject to the report is collected. Despite a list of suggested components five custom 
fields are provided. Enter further optional components to these custom fields.  

• Sample changer 
• MAS controller 
• High power equipment 
• LC-NMR 
• BEST 
• Liquid handler 
• Micro-Imaging 
• Diffusion, Cryoplatform 
• Additional cooling/heating unit 
• five custom fields 

i Only in case of an Accessory Test a report without any Inspection Lot can be created. 
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Field Service Test Report Tab – Button Panel (Figure 5-90) 

(5) Save 
Click Save (5) to apply all changes to the current report. 

(6) Last Save 
Click Last Save (6) to revert all changes in Report tab not applied yet. 

(7) Create Protocol & Spectra 
Click Create Protocol & Spectra (7) to create the spectra PDF and the protocol 
PDF of the report. All results set to be used for report and for Additional Report are 
included. Both parts of the report are marked as preliminary until it is finalized. 

(8) Show Protocol 
Click Show Protocol (8) to open protocol PDF file. The protocol PDF is marked as 
preliminary until it is finalized. This button is disabled if no protocol PDF was created 
yet. 

(9) Show Spectra 
Click Show Spectra (9) to open spectra PDF file. The spectra PDF is marked as 
preliminary until it is finalized. This button is disabled if no spectra PDF was created 
yet. 

(10) Finalize (non-finalized reports only)  
Click Finalize (10) to create the final report for signature. The finalized spectra and 
protocol PDF files can not be recreated. Finalizing a report finalizes the Inspection 
Lots and results the report is based on.  

(10) Export (finalized reports only)  
Click Export (10) to open a file browser to export the finalized report to hard disk. 
 

 

 

i 
Finalized means, no further changes to the report, the included Inspection Lots, their 
experiments and results can be done. In the Navigation panel, the corresponding icons 
are signed with a green checkmark. To make an Inspection Lot available again, the 
finalized report has to be deleted first. 
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6 Contact 
We provide service support as follows:  

The Bruker Service Stations or the Bruker Representatives will take care of virtually all aspects 
of Service world-wide. 

• Telephone support from Bruker Main Offices and remote diagnosis (NMR-check) is provided 
during working hours every working day, local holidays are observed. 

• Our laboratories to diagnose Covered Equipment malfunction(s). 
• Our replacement parts as required on an exchange (refurbished) or new part basis. 
• On site service will be provided by us during normal working hours and during our standard 

working week (Monday through Friday), excluding our observed holidays. 
• When a Bruker Service Engineer is sent to customer site, the customer will provide our 

personnel an unrestricted access to the Covered Equipment to perform service. If the Bruker 
Service Engineer is unable to gain access at a time previously agreed upon, wasted time or 
waiting time service will be charged additionally at our standard service rates. 

The customer will get a list of important e-mail addresses, telephone- and fax-numbers. 

Manufacturer:  

Bruker BioSpin GmbH 
Silberstreifen 4 
76287 Rheinstetten, Germany 
Germany 
Phone: +49 721-5161-0 
http://www.bruker.com 

Service Hotline: 
Phone: +49 721-5161-6155 
E-mail: NMR-Support@bruker.com 

Bruker Switzerland AG 
Industriestrasse 26 
8117 Fällanden 
Switzerland 

Service Hotline: 
Phone: +41 44 825 9898 
E-mail: Service.BBIO.CH@bruker.com 

Bruker BioSpin S.A.S 
34, rue de l'industrie 
67166 Wissembourg, France 

Service Hotline: 
Phone: +33 3 88 06 60 00 
Email: support-rmn@bruker.com 

Please refer to the Model No., Serial No. and Internal Order No. in all correspondence regarding 
the NMR system or components thereof.  
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